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Team Support

[

Enterprise Architect has been built from the ground up as a team modeling platform, and has extensive support for
groups of people working together on the same projects, sharing information, ideas and models. These team features
range from Baselines, Version Control and a Reusable Asset Service that protect the valuable modeling assets in a
team environment, to collaborative tools such as a Discussion Forum, Team Reviews and Gantt Charts to facilitate
people working together. The role based security system has been designed to encourage collaboration, allowing team
members to work together without the fear of interfering with each other’s work.

There are a wide range of deployment options that will suit any team development environment, allowing people to work
centrally or remotely in highly distributed environments. Corporate policy and standards can also be built into the models
with the use of Workflow Scripts. A free 'Lite' version of Enterprise Architect is also available for team members who
simply want to view the models, and high quality corporate documentation can be generated in a wide number of formats
to communicate with people outside the modeling platform.

Overview
Facility Description
Team Development Setup a collaborative modeling environment taking advantage of security,
-~ workflow and shared reference data.
4
e o~
ae e
Project Management Explore some of the ways you can manage your project and team within Enterprise
-~ - Architect.
Project Resources Track and mange the people and resources in your project.
Glossary Define a common vocabulary between your different teams, ensuring everyone is
on the same page.
Task Allocation Assign and Track your team's tasks in a Gantt View.
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Personal Tasks Record and manage your personal work within the project.

Model Mail Securely communicate with your team in an email style embedded within
Enterprise Architect, via Model Mail.

(@
'-—)

Project Calendar Track the deployment of resources, timeframes for tasks, and upcoming project
7= events such as meetings and milestones in a calendar format.

Use Case Estimation Form an estimate of the complexity of a system and an indication of the effort
required to implement the model.
L
.“Ii
Team Review A team based forum to discuss the development and progress of the project.
—
N

Making project data available in a distributed environment

Enterprise Architect offers a diverse set of functionality designed specifically for sharing projects in team-based and
distributed development environments; for example: Cloud-based solutions, network deployment of model repositories,
replication and XMI Import/Export.

Applying security to the model

User Security is a means of improving collaborative design and development by preventing concurrent editing, and
limiting the possibility of inadvertent model changes by users not designated as model authors.

Using an internal discussion forum

The Project Team Review facility is a discussion forum within your development team community to discuss the
development and progress of a project. You can link to the model elements that are the subject of a post thread in the
forum.

Similarly, you can develop a discussion about a specific element in the model as a component of the element, using the
Element Discussions facility.

Building company policy and project development guidelines into the project
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You can create workflow scripts that provide a robust approach to applying company policy and strengthening project
development guidelines, by validating against the policy and procedures within the model itself.

Standardizing and re-using project data

You can import and export Reference data (including Glossary and Issue information) from .XML files of another
iteration of the same model, or of a different model.
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Project Roles

Enterprise Architect is a powerful multi-disciplinary modeling platform that supports common work practices and
provides features to assist the entire spectrum of roles and disciplines across enterprise, business, engineering and
software projects. Each role will typically use different features of the tool. A number of the roles and their
responsibilities that the system supports are outlined here.

You can review a summary of the typical tasks supported for each role, or click on the appropriate role title to explore
how Enterprise Architect can assist you in carrying out that role within a model-driven project.

Roles and Responsibilities

Role Responsibilities
Business Analyst Create high-level models of business processes.
Software Architect Map functional requirements, perform real time modeling of objects, design the

Deployment model and detail the deliverable components.

Software Engineer Map Use Cases onto Class diagrams, detail the interactions between Classes, define
the system deployment and define software Packages.

Developer Perform round trip code engineering, including reverse engineering of existing code
and generation of code from Class elements.

Project Manager Assign resources to elements, measure risk and effort, estimate project sizes, and
manage element status, change control and maintenance.

Tester Create test scripts against elements in the modeling environment.
Implementation Manager e Track and assign maintenance-related items to elements within Enterprise
Architect

e Rapidly capture and keep records of maintenance tasks such as issues, changes,
defects and tasks

e Trace the maintenance of the items and processes involved in system

deployment
Technology Developer Create customized additions to the functionality already present within Enterprise
Architect.
Database Developer Develop databases, including modeling database structures, importing database

structures from an existing database and generating DDL for rapidly creating
databases from a model.
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Summary of Typical Tasks

Throughout a design and development project there are many different tasks to be performed, which could be carried out
either by one person or - more probably - by members of a team with different responsibilities. In either case, Enterprise
Architect supports most - if not all - of the responsibilities you might have on your project. The descriptions in this topic
cover a number of job roles that the system supports. For those that most resemble your role on a project, follow the job
title hyperlink to display a description of how that role might make use of Enterprise Architect, then follow links within
those topics to explore some of the features of importance to the role.

Summary of Typical Job Roles

Most of these roles work with specific types of diagram, so you might want to learn more about diagram types in general
and specific types of diagram in particular.

Several types of project team member might want to generate documentation on their work and report on how the project
is developing and changing. Using Enterprise Architect you can generate project reports in either document or web
format.

Role Responsibilities

Business Analyst For modeling:
e  Requirements
e High-level business processes
e Business activities
e  Work flows

e System behavior

Database Developer e Developing databases
e  Modeling database structures
e  Creating logical data models
e  Generating schema

e Reverse engineering databases

Software Architect e  Mapping functional requirements of the system
e  Mapping objects in real time
e  Mapping the deployment of objects

e  Defining deliverable components

Tester e Developing test cases
e Importing requirements, constraints and scenarios
e  (Creating Quality Test documentation

e Tracking element defects and changes

Software Engineer e  Mapping Use Cases into detailed Classes
e  Defining the interaction between Classes
e Defining system deployment

e Defining software Packages and the software architecture

Project Manager e Providing project estimates
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Developer

Implementation Manager

Technology Developer

Notes

Resource Management

Risk Management

Maintenance Management

Forward, reverse and round-trip engineering
Visualizing the system states
Visualizing Package arrangements

Mapping the flow of code

15 July, 2016

Modeling the tasks in rolling-out a project, including network and hardware
deployment

Assigning and tracking maintenance items on elements (issues, changes,
defects and tasks)

For creating or customizing:
UML Profiles

UML Patterns

Code Templates

Tagged Value Types
MDG Technologies

Add-Ins

e The Corporate, Business and Software Engineering, Systems Engineering and Ultimate editions of Enterprise
Architect have a user security feature that can be applied or turned off; if security is turned on, you need to have the

appropriate access permissions to use many of the facilities listed above

(c) Sparx Systems 2015 - 2016
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Business Analysts

A Business Analyst can use Enterprise Architect to create high-level models of business processes, including business
requirements, activities, workflow, and the display of system behavior.

Using Enterprise Architect, a Business Analyst can describe the procedures that govern what a particular business does.
Such a model is intended to deliver a high-level overview of a proposed system.

Business Analyst Tasks

Task Detail

Model High Level Using Analysis diagrams, you can model the high-level processes of the business.

Business Processes Analysis diagrams are a subset of UML 2.5 Activity diagrams and are less formal

than other diagram types, but they provide a useful means for expressing essential
business characteristics and requirements.

Model Requirements Gathering requirements is typically the first step in developing a solution, be it for
developing a software application or for detailing a business process; it is an
important step in the implementation of a project.

Using Enterprise Architect, you can define the Requirement elements, connect
Requirements to the model elements for implementation, connect Requirements
together into a hierarchy, report on Requirements, and move Requirements out of
model element responsibilities.

Model Business Activities You can use Activity diagrams to model the behavior of a system and the way in
which these behaviors are related to the overall flow of the system.

Activity diagrams do not model the exact internal behavior of the system but show
instead the general processes and pathways at a high level.

Model Workflow To visualize the cooperation between elements involved in the workflow, you can
use an Interaction Overview diagram, which provides an overview of sub activities
that are involved in a system.

Display System Behavior In displaying the behavior of a system as a Use Case diagram, Enterprise Architect
provides an easily understood tool for mapping the functional requirements and
behavior of a system.
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Software Architects

Software Architects can use Enterprise Architect to map functional requirements with Use Cases, perform real time
modeling of objects using Interaction diagrams (Sequence, Timing, Communication or Interaction Overview), design the
Deployment model and detail the deliverable components using Component diagrams.

Software Architect Tasks

Task Detail
Map Functional With Enterprise Architect you can take the high level business processes that have
Requirements of the been modeled by the Business Analyst and create detailed Use Cases.
System

Use Cases describe the proposed functionality of a system and are only used to
detail a single unit of discrete work.

Map Objects in Real Time You can use Interaction diagrams (Sequence and Communication diagrams) to
model the dynamic design of the system.

Sequence diagrams detail the messages that are passed between objects, and the
lifetimes of the objects.

Communication diagrams are similar to Sequence diagrams, but instead display the
way in which the object interacts with other objects.

Map Deployment of You can use Deployment diagrams to provide a static view of the run-time
Objects configuration of processing nodes and the components that run on the nodes.

Deployment diagrams show the connections between hardware, software and any
middleware that is used on a system.

Detail Deliverable Using Component diagrams, you can model the physical aspects of a system.

Components Components can be executables, libraries, data files or another physical resource

that is part of a system.

The component model can be developed from scratch from the Class model or can
be brought in from existing projects and from third-party vendors.
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Software Engineers

Software Engineers using Enterprise Architect can manually map Use Cases onto Class diagrams, detail the interactions
between Classes, define the system deployment with Deployment diagrams and define software Packages with Package
diagrams.

Software Engineering Tasks

Task Detail
Map Use Cases into Within Enterprise Architect you can study the Use Cases developed by the
Detailed Classes Software Architect, and with that information create Classes that fulfill the

objectives defined in the Use Cases.

A Class is one of the standard UML constructs that is used to detail the pattern from
which objects are produced at run time; to record the relationships between Use
Cases and Classes, you can create diagrams linking the elements with Realization
connectors, and/or map the Realization connectors in the Relationship Matrix.

Detail Interaction Between You can use Interaction diagrams (Sequence and Communication diagrams) to
Classes model the dynamic design of the system.

Sequence diagrams are used to detail the messages passed between objects, and the
lifetimes of the objects.

Communication diagrams are similar to Sequence diagrams, but instead display the
way in which objects interact with other objects.

Define System Deployment Deployment diagrams provide a static view of the run-time configuration of
processing nodes and the components that run on the nodes.

Deployment diagrams can be used to show the connections between hardware,
software and any middleware that is used on a system, to explain the connections
and relationships of the components.

Define Software Packages You can use Package diagrams to detail the software architecture.

Package diagrams are used to organize diagrams and elements into manageable
groups, declaring the dependencies.

Simple Use Case diagram
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Sequence Diagrams : Sequence Diagram for Login

Communication Diagrams : Communication Diagram for Login
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Developers

Developers can use Enterprise Architect to perform round trip code engineering, which includes reverse engineering of
existing code and generation of code from Class elements.

Developer Tasks

Task Detail

Round Trip Engineering Enterprise Architect gives you unparalleled flexibility in 'round tripping' software
from existing source code to UML 2.5 models and back again.

Round trip engineering involves both forward and reverse engineering of code,
keeping the model and code synchronized.

Reverse Engineering In Enterprise Architect, you can reverse engineer code from a number of supported
languages and view the existing code as Class diagrams, which illustrate the static
design view of the system.

Class diagrams show Classes and interfaces, and the relationships between them;
the Classes defined in UML Class diagrams can have direct counterparts in the
implementation of a programming language.

Forward Engineering As well reverse engineering your code into your model, you can forward engineer
elements of your model into code (code generation).

This way you can make changes to your model with Enterprise Architect and
quickly implement the changes in the source code.

Determine the System State To visualize the state of the system you can use State Machine diagrams to describe
how elements move between states, classifying their behavior according to
transition triggers and constraining guards.

State Machine diagrams capture system changes over time, typically being
associated with particular Classes; often a Class can have one or more State
Machine diagrams to fully describe its potential states.

Visualize Package Package diagrams help you design the architecture of the system; they are used to

Arrangement organize diagrams and elements into manageable groups, and to declare their
dependencies.

Follow the Flow of Code Activity diagrams help you develop a better understanding of the flow of code.

Activity diagrams illustrate the dynamic nature of the system; you can model the
flow of control between Activities and represent the changes in state of the system.

Simple Class Diagram
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Account
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Notes

e You can use State Machine, Package and Activity diagrams to better understand the interaction between code
elements and the arrangement of the code
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Project Managers

Enterprise Architect provides support for the management of projects. Project Managers can use the system to assign
resources to elements, measure risk and effort, estimate project sizes, and manage element status, change control and
maintenance.

Project Manager Tasks

Task Detail

Provide Project Estimates In Enterprise Architect you have access to a comprehensive project estimation tool
that calculates effort from Use Case and Actor objects, coupled with project
configurations defining the technical and environmental complexity of the work
environment.

Resource Management Managing the allocation of resources in the design and development of system
components is an important and sometimes difficult task; Enterprise Architect
provides you with an effective tool for assigning resources directly to model
elements and tracking progress over time.

Risk Management You can use the Risks window to assign risk to an element within a project; using
risk types you can name the risk, define the type of risk and give it a weighting.

Maintenance Within Enterprise Architect you can assign maintenance-related items to elements
and track them, providing rapid capture and record keeping for items such as issues,
changes, defects, and tasks.

You can also create and maintain a project glossary of processes, procedures, terms
and descriptions.
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Testers

Enterprise Architect provides a design testing facility for Testers and Quality Assurance personnel to create a range of
test scripts against elements in the modeling environment.

Testing Tasks

Task Detail

Test Cases With Enterprise Architect, you can set up a series of tests for each model element.

The test types include Unit, Acceptance, System, Integration, Inspection and
Scenario tests.

Import requirements, To use testing to maintain the integrity of the entire business process, you can
constraints and scenarios import requirements, constraints and scenarios defined in earlier iterations of the
development life cycle.

Requirements indicate contractual obligations that elements must perform within
the model.

Constraints are conditions that must be met in order to pass the testing process;
constraints can be:

e  Pre-conditions (states which must be true before an event is processed)
e Post-conditions (events that must occur after the event is processed) or

e Invariant constraints (which must remain true through the duration of the
event)

Scenarios are textual descriptions of an object's action over time and can be used to
describe the way a test works.

Create quality test Enterprise Architect provides the facility to generate high quality test
documentation documentation in .RTF, DOCX and PDF file formats.

Element defect changes In defect tracking you can allocate defect reports to any element within the model,
so that all who are involved in the project can quickly view the status of defects and
see which defects have to be addressed and which have been dealt with.
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Implementation Managers

Enterprise Architect provides support for the management of project implementation. You can track and assign
maintenance -related items to elements within Enterprise Architect, and rapidly capture and update records of
maintenance tasks such as issues, changes, defects and tasks. By providing a centralized facility for each element
involved in the deployment process Enterprise Architect offers a powerful solution for tracing the maintenance of the
items and processes involved in system deployment.

Implementation Tasks and Tools

Task Detail
Develop Deployment Using Deployment diagrams you can model the roll out of a project, including
Diagrams network deployment and workstation deployment.

Users involved in project deployment can add maintenance tasks to the diagram
elements.

Deployment diagrams provide a static view of the run-time configuration of nodes
on the network or of workstations, and the components that run on the nodes or are
used in the workstations.
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Technology Developers

Technology Developers are Enterprise Architect users who create customized additions to the functionality already
present within Enterprise Architect.

Additions include UML Profiles, UML Patterns, Code Templates, Tagged Value Types, Scripts, Custom Queries,
Transformations, MDG Technologies and Enterprise Architect Add-Ins. By creating these extensions the Technology
Developer can customize the Enterprise Architect modeling process to specific tasks and speed up development.

Developing Technologies

Extension Detail

UML Profiles By creating UML Profiles you can create a customized extension for building UML
models that are specific to a particular domain.

Profiles are stored as XML files and can be imported into any model as required.

UML Patterns Patterns are sets of collaborating Objects and Classes that provide a generic
template for repeatable solutions to modeling problems.

As patterns are discovered in any new project, you can create the basic pattern
template.

Patterns can be re-used with the appropriate variable names modified for any future
project.

Code Templates Code templates are used to customize the output of source code generated by
Enterprise Architect; in this way you can generate code languages not specifically
supported by Enterprise Architect and define how the system generates source code
to comply with your own company style guidelines.

Tagged Value Types Tagged Values are used in Enterprise Architect to extend the information relating
to an element in addition to the information directly supported by the UML
language.

A Tagged Value, strictly, is the value of a property of a modeling item, the
property being called a tag; for example: a Class element called Person might have
a tag called 'Age' with the Tagged Value of '42'.

More loosely, the combination of tag and value can be referred to as a Tagged
Value.

A Tagged Value Type is a group of parameters that define and/or limit the possible
values of a tag and, in many instances, how a specific value is assigned to the tag;
for example, the tag 'Age’ might have a Tagged Value Type of 'Integer’, so the user
simply types in a numeric value.

Alternatively, the type could be 'Spin', with lower and upper limits of, say, 20 and
120, so the user sets a value by clicking on arrows in the field to increment or
decrement the value within the limits of 20 and 120.

Typically, Tagged Values are used during the code generation process, or by other
tools to pass on information that is used to operate on elements in particular ways.

MDG Technologies MDG Technologies can be used to create a logical collection of resources that can
contain UML Profiles, Patterns, Code Templates, Image files and Tagged Value
types that are accessed through a technology file.

Enterprise Architect Using Add-Ins you can build your own functionality into Enterprise Architect,
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Add-Ins creating your own mini programs that can extend the capabilities of the system,
defining your own menus, and creating your own Custom Views.
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Database Developers

Enterprise Architect supports a range of features for the development of databases, including modeling database
structures, importing database structures from an existing database and generating DDL for rapidly creating databases

from a model.

Database Development Tasks

Task

Create Logical Data
Models

Generate Schema

Reverse Engineer Database

Detail

With Enterprise Architect you can build database diagrams using the built-in UML
Data Modeling Profile.

This supports the definition of Primary and Foreign keys, cardinality, validation,
triggers, constraints and indexes.

By using Enterprise Architect's DDL generation function you can create a DDL
script to create the database table structure from the model.

Enterprise Architect currently supports:

e DB2

e  Firebird

e MS Access

e MySQL

e MS SQL Server
e Oracle

e PostgreSQL

e Informix (#)

e Ingres (#)

e InterBase (#)

e Sybase Adaptive Server Anywhere (#)
e Sybase Adaptive Server Enterprise (#)

(#) - no further development will be undertaken on these DBMS's, due to a general
lack of interest for these products from the Enterprise Architect user base. Which
will allow Sparx Systems to concentrate its efforts on the other areas of Database
modeling.

Using an ODBC data connection you can import a database structure from an
existing database to create a model of the database.

By generating the model directly from the database you can quickly document your
work and create a diagrammatic account of a complex database through the
graphical benefits of UML.

Example Data Model Diagram

(c) Sparx Systems 2015 - 2016
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User Security

User Security in Enterprise Architect is a means of blocking the use of model update functions across the model by
means of access permissions for each function, and protecting specific elements and diagrams from change by means of
user locks. The intent is not to prevent access to information, but to prevent inadvertent changes to data.

Security is an optional facility in the system. If required it is enabled by the Security Administrator, who at the same time
sets the security policy to either:

e  Require User Lock to Edit - the whole project is blocked against editing and the user locks an object to open it and
edit it, or

e  User/group locking - the whole project is open for editing and the user locks an object to protect it from being edited

The Security Administrator also sets up the user and group IDs and passwords, which every user requires to log in to the

model when security is enabled. Access permissions are assigned to the user IDs to determine which update functions the

user can apply. The users can still view any information in the project. If security is not enabled in the project, no login is
required and users do not have to have access permissions to perform update functions.

Access
Ribbon Configure > Security
Menu Project | Security

Security Operations

Operations For Detail

Administrators A number of security tasks can be performed only by users with Administrative
permissions to the security operations. The person who enables security receives
online instructions to login as Admin. This login ID automatically:

e Has access permissions to perform all security operations

e [s a member of an Administrators user group, which also has access
permissions to perform all security operations

Users Other security tasks can be performed by users who do not have Administrative
rights, on work performed under their own user ID. These users must still have the
appropriate access permissions to perform many of these 'user' tasks.

Notes

e  User Security can be enabled in the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions of Enterprise Architect
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Enable/Disable Security

User security is not automatically enabled on the system. If your organization requires the security facilities, the Security
Administrator enables them using an authorization key obtained from the Sparx Systems website. Similarly, if security
facilities are no longer required, the Security Administrator explicitly disables security, again using the authorization
key.

Access
Ribbon Configure > Security > Manage > Enable Security
Menu Project | Security | Enable Security

Enable and Disable User Security

Step Action

1 Obtain the authorization key from the Sparx Systems website on:
e the 'Team Modeling Resources' section (Trial User) or

e the 'Registered Users' section (Registered User; you must also have your Registered Users login and

password)
The two authorization keys are not interchangeable - the Trial User key does not work on a registered user
installation.
2 In Enterprise Architect, select the 'Enable Security' menu option.

The 'Enter authorization' dialog displays.
3 In the 'Enter authorization key' field, type the authorization key from the Sparx Systems website.

4 If required, select the 'Automatically apply Exclusive Edit Locks to diagrams' checkbox.

In standard (User/Group Locking) mode, this option blocks multiple users from simultaneously attempting
to modify the same diagram (see Notes).

This option is ignored in 'Require User Lock to Edit' security mode.

5 Click on the OK button.
Security is enabled, and an Admin user and Administrators user group are created, both with all access
permissions; the Admin user has the password of 'password'.

6 Select the 'Project | Security | Login as Another User' menu option, and log in as 'Admin’ with the initial
password of 'password'.

It is recommended that you change the Admin password immediately.

7 Set up users and permissions as required.
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Notes

e Once security has been enabled, you must have 'Security-Enable/Disable’ permission to turn it off - the initial Admin
administrator and Administrators group automatically have this permission; the system prompts you to log off the
project and log on again, but this is not strictly necessary

e If you re-enable security, be aware that any changes you have made to the Admin user (password and reduced access
permissions) are reset to 'password' and full access; similarly, the Administrators user group is reinstated with full
access permissions

e  The 'Automatically apply Exclusive Edit Locks to diagrams' option is not displayed when disabling security,
therefore to toggle the setting whilst security is enabled you must disable security and re-enable it; security settings
(users, groups and permissions) and locks on elements are not affected by this action

e [f the 'Automatically apply Exclusive Edit Locks to diagrams' option is selected, as a user modifies a diagram the
system automatically applies a User Lock to the diagram, preventing any other user from modifying it
It is creating a difference between the database and buffer versions of the diagram that triggers the temporary lock,
and elimination of difference that releases the lock; therefore, the system releases the lock when:
- The user saves the changes to the diagram, with the Save icon or keyboard keys
- The user undoes the last remaining action in the 'Undo' list
- The user saves or discards changes via the system prompt when they close the diagram

If the diagram already has a User Lock or Group Lock that does not exclude the current user, this lock is set aside

and saved when the temporary User Lock is applied; when the temporary User Lock is released, the pre-existing
lock is restored
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Set Security Policy

The security policy determines how security mechanisms are applied and interpreted on the system. There are two
possible security policies in Enterprise Architect:

e User/Group Locking mode - All elements and diagrams are considered unlocked and anyone can edit any part of the
model; however, when you edit a diagram, Package or element, you lock the element or set of elements at either the
user level or group level and no other user can edit the object
This mode is good for cooperative work groups where there is a solid understanding of who is working on which
part of the model, and locking is used mainly to prevent further changes or to limit who has write access to a part of
the model

e Require User Lock to Edit mode - More rigorous: the model is read-only, and everything is locked so that nobody
can edit anything unless they explicitly check out the object with a user lock; a single 'check out' function operates
on a diagram to check out the diagram and all contained elements in one go.

There are also functions on the context (right-click) menus of Packages, diagrams and elements in the Project
Browser to apply a user lock when this mode is in use

You would use this mode when there is a strict requirement to ensure only one person can edit a resource at one
time; this is suitable for much larger projects where there might be less communication between users

For element locking, the two policies are modified by the 'Apply Locks to Connectors' menu option. If this option is:

o Selected, security locks on elements are applied to all connectors owned by the locked elements (users other than the
locking user cannot edit the connectors)

e  Unselected, security locks on elements do not apply to the owned connectors (users other than the locking user can
create and edit the connectors freely)

Access
Ribbon Configure | Security > Manage> Require User Lock to Edit (select for 'Require
User Lock to Edit' mode, deselect for 'User/Group Locking' mode)
Menu Project | Security | Require User Lock to Edit (select for 'Require User Lock to Edit'
mode, deselect for 'User/Group Locking' mode)
Notes

e Only the Admin Security Administrator, with Admin permissions, is able to set the security policy applied

e When you add new elements in 'User/Group Locking' mode (elements editable by default), no user lock is created
automatically for the newly created element

e When you add new elements in 'Require User Lock to Edit' mode (elements locked by default), a user lock is created
on the new element to enable instant editing

e For all connectors other than Aggregations, the connector is owned by the source element in the relationship (as
currently applied in Version Control)
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Maintain Groups

Whilst you can apply access permissions to each user individually, it is easier and more convenient to assign all users
with the same access permission(s) to a security group, and assign the permissions to all the members of that group in a
single action.

The security group also acts as a mailbox for Model Mail, where the group name can be selected as the addressee; when
an internal mail is sent to the group, all members of the group receive that email in their Model Mail view. The group
name can act as either:

e A mail list, in which case each group member receives their own copy of the message, or

e A mail box, in which case the email is a single entity and the group members do not receive separate instances of it;
if one group member responds to or deletes the email, the other group members see that action as if they had
performed it themselves

Access
Ribbon Configure > Security > Groups
Menu Project | Security | Manage Groups

Set up a security group

Field/Button Action
New Click on this button to clear the fields ready to define a new group.
Group Name Type the security group name.
Description Type a description of the group.
Save Click on this button to save the group definition and add it to the Groups list.
Link to Active Directory Select this checkbox to enable linking to a Windows Active Directory Group from

which to import users. The 'Select Group' dialog displays on which you specify the
Windows Active Directory Group to attach to. You then start importing the users
when you click on the Sync button.

You must have 'Accept Active Directory Authentication' permission in Windows to
link to the Active Directory; an error message displays if you do not have this.

Shared Mail To make the group name act as a mail box, select this checkbox against the name in
the list.

To use the group name as a mail list, leave the checkbox unselected.

Active Directory Link Displays the address of the Active Directory Group that this user group is linked to,
if any.
Sync Enabled if the group is linked to a Windows Active Directory. Click on this button

(c) Sparx Systems 2015 - 2016 Page 28 of 105 Created with Enterprise Architect



User Guide - Team Support 15 July, 2016

to synchronize the group with the Active Directory (that is, import specific users
into the model from the Active Directory). You use this option when you initially
set up the User Group; subsequent user IDs must be added to the user group
manually.

Permissions Lists the permissions that can be assigned to the user group. Select the checkbox
against each permission the members of the group are to have.

Users After you add users to the user group, they are listed in this panel.
Close Click on this button to close the dialog.
Notes

®  You must have 'Security - Manage Users' permission to manage user groups; the initial Admin administrator and
Administrators group automatically have this permission

e You do not define groups as group logins with passwords; if you intend to use a group login, you can define a
single-user login and password that all group members use (that is, Enterprise Architect allows multiple logins under
one user ID)

e  Users that have been imported from an Active Directory are listed in the 'Manage Users' dialog'; if the 'Accept
Windows Authentication' option is enabled on that dialog, when a user opens the model the system checks the
database for their Windows ID and, if it matches, automatically logs the user in without prompting for a password

o  Emails already sent to a group as a mail list and those sent to a group as a mailbox cannot be interchanged; if you
change the status of the 'Shared Mail' checkbox, the only way to change the distribution of past emails is to forward
them to the group name again

®  You can subsequently edit the group name; changes are automatically reflected in the internal Model Mail mail list
or mail box
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Maintain Users

When you have enabled security, you create the user definition for each user that has access to the model. The user
definition consists of the user ID and password, the permissions the user has and the user groups the user is a member of.

Access
Ribbon Configure > Security > Users: New
Menu Project | Security | Manage Users: New

Set up a user for your model

Step Action

1 You can either set up the user manually, as described here, or import the user IDs from a Windows Active
Directory.

If you are importing the user IDs from a Windows Active Directory, do not complete any user detail fields
on this dialog, but select the 'Accept Windows Authentication' checkbox and go to the Import User IDs
from a Windows Active Directory Help topic.

2 In the:
e 'Login' field, type the user ID
e 'Firstname' field, type the user's first name
e 'Surname' field, type the user's last name
Optionally, in the 'Department' field, type the name of the user's department.

The 'Add User to Authors' checkbox defaults to selected, to add the new user to the list of authors of
model elements. If the user is not to be added to the list of authors, deselect the checkbox.

3 Click on the Save button, and then click on the Change Password button.
The 'Change Password' dialog displays.

4 In the "New password' field, type the user's password.
This can be any number of characters in length.

(As this is a new user, the 'Enter old password' field is disabled.)
5 In the 'Retype new' field, type the user's password again, for confirmation.

6 Click on the OK button.
A Password Changed message displays.
Click on the OK button to return to the 'Security Users' dialog.

7 In the 'User Groups' panel, select the checkbox against each user group that the user is to be a member of.
This assigns to the user all permissions that the selected groups have.
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8 In the 'User Permissions' panel, select the checkbox against each permission that you want to assign to the
user as an individual. If a permission is grayed out and already ticked, the user already has that permission
as a member of a User Group.

9 The user definition is complete. You can now either:
e  (lick on the New button to add another user, or

e  Click on the Close button to exit the 'Security Users' dialog

Notes

®  You must have 'Security - Manage Users' permission to maintain users; the initial Admin administrator and
Administrators group automatically have this permission

e You can transport the user definitions between models as Reference Data, using the 'Project | Model Import/Export |
Export Reference Data' and Tmport Reference Data' options
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Import User IDs From Active Directory

Whilst you can define each of your model users individually and specifically for Enterprise Architect security, you can
also import your Windows user IDs from Windows Active Directory and use those as the security user IDs with
Windows Authentication. If you set up your security user IDs in this way, when a user opens the model the system
checks the users database for their Windows ID and, if it matches, automatically logs the user in without prompting for a
password.

As a pre-requisite, you create an appropriate user group into which to import the user IDs; you can also use this to assign
appropriate permissions to the user IDs as a whole.

Access
Ribbon Configure > Security > Users
Menu Project | Security | Manage Users

Import user IDs from Windows Active Directory

Step Action

1 On the 'Security Users' dialog do not complete any user details fields. Instead, select the 'Accept Windows
Authentication' checkbox and click on the Import button.

The Tmport Users' dialog displays.

2 In the 'Security Group' panel, select the checkbox against the appropriate security group to contain the
imported user IDs.

3 Click on the Add button.
The 'Select Users' dialog displays.

4 If the 'Select this object type' field has not defaulted to 'Users":
1. Click on the Object Types button; the 'Object Types' dialog displays
2. Select the checkbox against 'Users' (the type of object to import from the Active Directory).
3. Click on the OK button to return to the 'Select Users' dialog.

5 Click on the Locations button.
The 'Locations' dialog displays.

6 Browse for and select the location to import from, within the Active Directory.
Click on the OK button to return to the 'Select Users' dialog.

7 In the 'Enter the object names to select' field, either:

e Type in the user IDs individually (click on the examples link to see examples of the correct formats)
and go to step 13, or

e C(Click on the Advanced button to search for IDs; the 'Select Users' dialog redisplays showing a
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'Common Queries' tab

8 In the 'Name' and 'Description’ fields, type any characters or text that help identify the IDs you are
searching for.

9 In the 'Starts with' field, click on the drop-down arrow and, if necessary, select a different qualifier.

10 Optionally, to further filter the IDs to search for, select the 'Disabled accounts' or 'Non-expiring password'
checkboxes, and/or select a value in the 'Days since last logon' field.

11 Click on the Find Now button to initiate the search, and to display a list of IDs in the bottom panel of the
dialog.

You can vary the types of information shown here by clicking on the Columns button and selecting the
column headings to display, then dragging the column titles into the sequence you prefer.

12 When you have identified the IDs to import, click on a required ID (or press Ctrl or Shift while you click
to select several) and click on the OK button.

The 'Select Users' dialog redisplays, with the selected ID or IDs listed in the 'Enter the object names to
select' field.

13 Click on the OK button to redisplay the 'Import Users' dialog with the selected users' names listed in the
'Users' panel.

14 Click on the Import button to add the user IDs to the 'Security Users' dialog.

15 Click on a user ID to populate the dialog fields with the user ID details.

You can also set group membership and/or single permissions here.

Notes

®  You must have 'Security - Manage Users' permission to maintain users; the initial Admin administrator and
Administrators group automatically have this permission

e As a security measure, the Window Authentication is automatically deactivated if the project file is moved to a
different location; once the file has been relocated, you can toggle the 'Accept Windows Authentication' checkbox to
reactivate Windows Authentication.

e  Enterprise Architect generates random passwords for Windows user IDs; however, if necessary you can assign a
new password to an imported user ID
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View All User Permissions

When a user has been set up on the system with their appropriate access permissions, you can periodically monitor the
list of permissions to verify what they are able to do and check that their profile is up to date. The access permissions
shown as selected are derived from their individual profile and from their membership of security groups.

Access
Ribbon Configure > Security > Users
Menu Project | Security | Manage Users

Display the permissions assigned to a user ID

Step Action

1 On the 'Security Users' dialog, select the user ID in the 'Users' list so that the details display in the 'User
Details' panel.

2 Review the list of permissions in the 'User Permissions' panel. The user has all access permissions for
which the checkbox is selected, and does not have the permissions for which the checkbox is clear.

Notes

e  You must have 'Security - Manage Users' permission to maintain users; the initial Admin administrator and
Administrators group automatically have this permission

e On this dialog you can select and deselect checkboxes in the 'User Permissions' panel to edit the user's individual
access permissions, but you cannot change permissions assigned via the User Groups; click on the Save button to
save any changes
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List of Available Permissions

In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions, if security is enabled,
users can update information if they have the appropriate access permissions for the data update tasks for that type of
data. The tasks that a user can perform with each access permission are listed here.

Some permissions take precedence over others. For example, if a user has 'Use Version Control' permission, they can
modify model elements on import even if they do not have 'Update Element' permission.

Permissions

Permission

Administer Database
Admin Workflow
Audit Settings

Audit View
Baselines - Manage
Baselines - Restore model
Change Password
Check Data Integrity
Configure Datatypes
Configure Images
Configure Packages

Configure Resources

Configure Stereotypes
Configure Version Control

Export XMI

Generate Documents

Generate Source Code and
DDL
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Enables the user to

Compact and repair a project database.

Develop and manage workflow scripts.

Change the audit settings in the 'Audit Settings' dialog.

Enable auditing and display data in the 'Audit View' and 'Audit History' tab.
Create, delete, import and export Baselines.

Merge data into the project model from a Baseline or XML file.
Change your own password.

Check and repair project data integrity.

Add, modify and delete datatypes.

Configure alternative element images.

Configure controlled Packages and Package properties.

Create and manage Resources window items: document templates, patterns, profiles
and favorites. Also required to create and modify CSV Specifications.

Add, modify and delete Stereotypes.
Set up version control options for the current model.

Export a model to XMI. Also required for CSV Import and Export, and for creating
and editing CSV Specifications.

Generate document and web reports from model Packages.

Generate source code and DDL from a model element, and synchronize code
against model elements if it already exists.

Import a model from XMI. Also required for CSV Import and Export, and for
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Import XMI
Lock Elements

Manage Diagrams

Manage Glossary
Manage Issues

Manage Project Calendar

Manage Project Settings

Manage Reference Data -
Update

Manage Replicas
Manage Tests

Reverse Engineer from
DDL and Source Code

Security - Enable/Disable
Security - Manage Locks
Security - Manage Users

Spell Check

Transfer Data

Transform Package

Update Diagrams

Update Elements

Use Version Control

View Locks
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creating and editing CSV Specifications.
Lock an element or Package.

Create new diagrams, copy and delete existing diagrams, and save a diagram as a
UML Pattern.

Create, edit and delete glossary items in the Project Glossary.
Update and delete model Issues.

Add, update and delete Project Calendar events; those without this permission can
view calendar items.

Update and manage project-wide settings including:
e The available project resources, metrics and risks
e  The default element font for the model and

e  The model default diagram

Update and delete reference items.

Create and synchronize replicas.
Update and delete Test records.

Reverse engineer from source code or ODBC, and synchronize model elements
against code.

Disable user security in Enterprise Architect.

View and delete element locks set by other users.
Maintain users, groups and assigned permissions.

Spell check a Package and set the spell check language.
Transfer model between different repositories.

Perform transformations of Packages and elements.

Update diagram appearance, properties and layout, including on the "Page Setup
dialog.

Save model changes (including deletions) for elements, Packages, and
relationships.

Check files in and out using version control.

Display all locks that have been set in the model.
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View and Manage Locks

When security is enabled, users lock and unlock model elements in order to work on them, which can require monitoring
and control. You can periodically view and, if necessary, delete the active locks placed on elements by users.

Access

Ribbon

Menu

Configure > Security > Locks

Project | Security | Manage Locks

Manage user locks

Step

1

Notes

Action

On the 'Manage Locks' dialog, in the 'View Locks For' panel, click on the radio button for the type of lock
to view.

e All

e  Groups Only

e  Users Only

Locks of the selected type are listed in the 'Active Locks' panel.

To remove a lock, click on it and click on the Unlock Selected button.

You can select (and deselect) multiple locks by pressing Ctrl as you click on each one, or Shift as you
click on the last block in a range.

You can also select all locks in the list by clicking on the Select All button, and clear that selection by
clicking on the Select None button (or by clicking off the list).

When you have finished reviewing the locks, click on the Close button to close the dialog.

e You must have 'Security - Manage Locks' permission to view and delete user locks; the initial Admin administrator
and Administrators group automatically have this permission

e The 'Manage Locks' dialog does not currently show any Full locks set in the model

e Ifyou want to display the resulting information in a more readable layout, you can resize the dialog and its columns
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Password Encryption

In releases of Enterprise Architect prior to 7.1, Security Administrators of projects on SQL Server or Oracle repositories
can encrypt the password used to set up the connection between Enterprise Architect and the repository. The system user
does not have the real password, thereby preventing them from accessing the repository using other tools such as Query
Analyzer or SQLPlus.

For password encryption for all repositories at and beyond release 7.1, you provide the connection but protect the
password using model shortcuts.

Access
Ribbon Configure > Security > Manage > Encrypt Password
Menu Project | Security | Encrypt Password

Encrypt a repository password

Step Action

1 In the 'Password' field, enter the password to access the repository.

The 'Encrypted' field displays the modified password to be provided to users.

2 Instruct users to connect Enterprise Architect to the repository using the encrypted password prefixed with

$S.

Notes
e Do not click on the Test Connection button as it can cause an error with encrypted passwords

e  For SQL Server repositories, you must enter the Initial Catalog details from the 'All' tab of the 'Data Link Properties'
dialog
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Change Password

It is recommended that users of any computer system change their passwords - or have them changed - at regular
intervals. When security is enabled in Enterprise Architect, users can change their own passwords or, if the user is unable
or not authorized to do this, a Security Administrator can set or change the user's password.

Access
Ribbon Configure > Security > Manage > Change Password (User)
Configure > Security > Manage > Users (Administrator)
Menu Project | Security | Change Password (User)

Project | Security | Manage Users (Administrator)

User - Change your own user password

Step Action

1 On the 'Change Password' dialog, in the 'Enter old password' field, type your current password.

2 In the 'New password' field, type your new password.

This can be any number of characters in length.
3 In the 'Retype new' field, type your new password again, for confirmation.

4 Click on the OK button.
The Password Changed message displays.

5 Click on the OK button to clear the message.

Use your new password next time you log in.

Administrator - Set or change any user's password

Step Action

1 On the 'Security Users' dialog, in the 'Users:' panel, click on the user's name.

The user's details display in the dialog fields.

2 Click on the Change Password button.
The 'Change Password' dialog displays.
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3 In the 'New password' field, type the user's new password.
This can be any number of characters in length.

You do not have to enter the user's current password.
4 In the Retype new' field, type the user's password again, for confirmation.

5 Click on the OK button.
The Password Changed message displays.

6 Click on the OK button.
7 By secure means, notify the user of their new password.
Notes

e A user must have Change Password permission to change their own password; the initial Admin administrator and
Administrators group automatically have this permission

e A Security Administrator must have Security - Manage Users permission to change other users' passwords; the
initial Admin administrator and Administrators group automatically have this permission
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Lock Model Elements

If you need to set a lock on a Package, element or diagram, or clear that lock, you can do so from either the Project
Browser or - for an element or diagram - from within a diagram. You follow one of three procedures, depending on
whether you are:

e Locking an element or diagram under the 'User/Group Locking' security policy
e  Locking a Package under the 'User/Group Locking' security policy

e  Locking an element or diagram under the 'Require User Lock to Edit' security policy

Notes

e You must have 'Lock Elements' permission to lock an element or diagram
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Lock Objects Under User/Group Locking

Under the User/Group Locking security policy, if you need to set or release a lock on an element or diagram, you can do
so from either the Project Browser or from within the diagram.

Access
Ribbon e  Design > Diagram > Manage > Lock  (on selected diagram)
e Design > Element > Manage > Lock  (on selected element)
Main Menu Project | Security | Lock Selected Item...
Context Menu Select one of:

Project Browser | Right-click on diagram | Lock
Project Browser | Right-click on element | Lock

Project Browser | Select a Package, Diagram or Element and press
Ctrl+Shift+L

Diagram | Right-click on diagram background | Lock Diagram
Diagram | Right-click on element | Lock Element  or

Diagram | Select an element and press Ctrl+Shift+L

Set a lock on an element or diagram

Step Action

1 On the '"Lock Element' or 'Lock Diagram' dialog, in the "Lock Type' panel, select the radio button for the

required option:

e 'No lock' - do not set a lock on this object; clear any existing lock that you have set, or clear any Full
lock that other users have set

e 'Full lock' - lock this object so that no-one can edit it without specifically clearing the lock

e 'User lock' - lock this object so that only you can make further edits; other users cannot unlock or edit

the object

e 'Group lock' - lock this object so that any member of the specified group can edit the object; other
users cannot unlock or edit the object

2 If you have selected the 'Group lock' option, in the 'GroupID' field click on the drop-down arrow and
select the group containing users that can edit the object.

The 'GroupID' drop-down list only includes groups that you are a member of.

3 Click on the OK button.

Notes
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e To check whether the project security is in User/Group locking mode, select Project | Security; the 'Require User
Lock to Edit' option should be deselected

e You must have Lock Elements permission to lock an element or diagram

e If the item already has a lock, only the corresponding lock option and the "No lock' option are highlighted; you have
to release the lock in order to set a different type of lock

e Ifadiagram is locked and you select an element on it, the element border displays in red, indicating that you cannot
move it or resize it

e Ifan element is locked and you click on it on a diagram, the element border displays in black; you can display the
properties but not change them

e Ifyou select the 'Full Lock, no-one may edit' option, a red exclamation mark displays against the object in the
Project Browser

e Ifyou select the 'User Lock, locking user may still edit' or 'Group lock, locking group may still edit' options, a blue
exclamation mark displays against the object in the Project Browser; other users see a red exclamation mark
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Lock Packages Under User/Group Locking

If, in User/Group locking mode, you want to lock or unlock the contents of a Package, you can do so in a single
operation. You can set the lock on the entire contents (including child Packages), just on the top-level Package content,
or just on the elements or diagrams in the Package.

Access
Main Menu e  Project | Security | Lock Selected Item...
Ribbon e Design > Package > Manage > Lock  (on selected Package)
Context Menu e Project Browser | Right-click on Package | Package Control | Lock Package

e Project Browser | Click on a Package, then press Ctrl+Shift+L

Lock or Unlock a Package

Step Action

1 In the '"Lock Type' panel, select the appropriate radio button for the lock to apply:

e No lock - do not set a lock on this Package; clear any existing lock that you have set, or clear any Full
lock that other users have set

e  Full lock - lock this Package so that no-one can edit it without specifically clearing the lock

e  User lock - lock this Package so that only you can make further edits; other users cannot unlock or
edit the Package

e  Group lock - lock this Package so that any member of the specified group can edit the object; other
users cannot unlock or edit the Package

2 If you have selected the 'Group lock' option, in the 'GrouplD' field click on the drop-down arrow and
select the group containing users that can edit the object.

The 'GroupID' drop-down list only includes groups which you are a member of.

3 The 'What to Process' checkboxes default to selected to also lock:
e Elements and/or diagrams in the Package
e The contents of child Packages (that is, the whole branch)

If you want to exclude any type of Package content from the change in lock status, deselect each
appropriate checkbox.

4 Click on the OK button to apply the lock.

Notes
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e  To check whether the project security is in User/Group locking mode, select 'Project | Security'; the 'Require User
Lock to Edit' option should be deselected

e  You must have 'Lock Elements' permission to lock a Package

e If the Package is already locked, only the corresponding lock option and the 'No lock' option are highlighted; you
have to release the lock in order to set a different type of lock

e Ifyou select the 'Full Lock, no-one may edit' option, a red exclamation mark displays against the Package in the
Project Browser

e Ifyou select the 'User Lock, locking user may still edit' or 'Group lock, locking group may still edit' options, a blue
exclamation mark displays against the Package in the Project Browser; other users see a red exclamation mark
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Lock Objects Under Require User Lock to Edit

In the Require User Lock to Edit security mode, if you want to edit one or more of the diagrams or elements in a
Package, you must set a User Lock on either the specific objects or the Package that contains them. You can set or
release the lock from either a diagram or the Project Browser. Once you have set a lock, only you or the Security
Administrator can release it again; no other user can release your locks.

Access
Main Menu e  Project | Security | Lock Selected Item...
Ribbon e Design > Package > Manage > Lock  (on selected Package)
e Design > Diagram > Manage > Lock  (on selected diagram)
e Design > Element > Manage > Lock  (on selected element)
Context Menu Select one of:

e Project Browser | Right-click on Package | Package Control | Apply/Release
User Lock or

e  Project Browser | Right-click on diagram | Apply/Release User Lock  or
e Project Browser | Right-click on element | Apply/Release User Lock  or

e Project Browser | Select a Package, Diagram or Element, then press
Ctrl+Shift+L.  or

e Diagram | Right-click on background | Apply/Release User Lock or
e Diagram | Right-click on element | Apply/Release User Lock  or
e Diagram | Select an element, then press Ctrl+Shift+L

Set or clear a user lock in Require User Lock to Edit security mode

Step Action

1 On the 'Set User Lock' dialog, click on either the:
e 'Apply User Lock' radio button to set the lock or

e 'Release User Lock' radio button to clear the lock

2 For a Package, if you want to also lock all child Packages, select the 'Include Child Packages' checkbox.
If any elements in the Package tree are locked by other users, a list of elements that couldn't be locked
displays.

3 Click on the OK button.

The system locks or unlocks:
e The selected element
e The selected diagram and any elements in the diagram, or

e The Package and all elements and diagrams in the top level of the Package
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Notes

e To check whether the project security is in Require User Lock to Edit mode, select 'Project | Security'; the 'Require
User Lock to Edit' option should be selected

e  You must have 'Lock Elements' permission to lock a Package

e When you set a user lock, a blue exclamation mark displays against the object or objects that are locked; other users
see these as red exclamation marks
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Locked Element Indicators

When a user sets a lock on an item through User Security, the lock status of the item is indicated in the Project Browser
by a marker against the item - a red or blue exclamation mark - as shown:
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The effect of the lock and the meaning of the status marker depend on the security policy applied to your project.

Require User Lock to Edit

Marker

Meaning

No marker

There is no lock, the item is not editable, but any user can now apply a user lock to
edit the item.

Blue exclamation mark

You have applied a user lock and can edit the item; no other user can release the
lock, set their own lock or edit the item.

Red exclamation mark

Another user has applied a user lock, and you cannot release the lock, set your own
lock or edit the item.

You can find out which user has locked the item.
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User/Group Lock

Marker Meaning
No marker There is no lock, the item is editable, but any user can now apply a user or group
lock.
Blue exclamation mark The item has a lock set by you or a group including your user ID as a member, and

you can edit the item.

Red exclamation mark The item has a lock set by another user, or a group of which you are not a member;
you cannot edit the item.

You can find out which user has locked the item.

The red exclamation mark also indicates that you or another user has set a full lock
on the item. Any user can clear that lock.

Notes

e [fadiagram is locked and you select an object on it, the object border displays in red; this indicates that you cannot
change the location or size of the object on the diagram
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Identify Who Has Locked An Object

When you are working in your model, you might find that you are unable to update an element, diagram or Package. If
you cannot update any object, this might mean that you do not have the access permissions to update diagrams or
elements. However, if the object in the Project Browser has a red exclamation mark next to it this indicates that either
another person has placed a user lock or group lock on the object, or you or another user have put a full lock on the
object.

You can quickly establish if the lock is a full lock (which you can remove) or which user has set a user or group lock.

Access

Context Menu e Project Browser | Right-click on Package | Package Control | Lock Package
e  Project Browser | Right-click on Diagram | Lock Diagram

e  Project Browser | Right-click on Element | Lock

Identify the lock holder

Step Action

1 In the Project Browser, right-click on the diagram, Package or element that has a red lock indicator, and
select the appropriate "Lock' option.

If the lock is:
e A Full lock, the 'Lock <object>' dialog displays, and you can delete the lock and set your own

e A user lock or group lock, a message displays showing the user ID of the person or group who
currently holds the lock on that item; click on the OK button to close the dialog

Notes

e You must have Lock Elements permission to lock or clear the lock on a Package, element or diagram
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Manage Your Own Locks

As you are working in your model, you might set user locks on elements, diagrams and Packages so that you can work
on them and protect that work while it is progress. Having completed your work, you might then want to remove those
locks. You can do this on each object individually, using the same procedure as you used to set the lock. You can also
display a list of all the locks you have set, and remove selected locks or all locks at once. This is especially useful when
working under the 'Require user locks to edit' security policy.

Access
Ribbon Configure > Security > Manage > Manage My Locks
Menu Project | Security | Manage My Locks
Keyboard Shortcuts Ctrl + Shift + L

Manage your own locks

Notes
e  You need to have Lock Elements access permission to set user locks on modeling elements, but you do not require
any access permission to list or clear them using this procedure

Step Action

1 All the locks that you have set in the model are listed on the "My Locks' dialog.

This dialog does not show Full locks or Group locks.

2 If you intend to clear locks, either:
e Select a single lock you intend to clear
e  Press Ctrl or Shift as you select a number of locks or a range of locks respectively, to clear
e Click on Select All to select all of your locks, or

e Click on Select None to clear your selection, if you have made an error

3 If you have selected locks to clear, click on the Unlock Selected button.

The objects that were locked are now unlocked.
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Project Calendar

The Project Calendar provides a project management overview in calendar format of the deployment of resources,
timeframes for tasks, and upcoming project events such as meetings and milestones. The calendar displays in the
Diagram View workspace, consisting of a:

e (Calendar panel, displaying months of the year

e Diary panel sectioned into days or weeks

e  Toolbar at the top of the window, which enables you to define what information is displayed and how it is formatted

Access

Ribbon

Menu

Features

Screen area

Calendar Panel

Diary Panel
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Start > Today > Calendar

Project | Calendar

Description

The calendar panel, when viewed normally on the screen, displays a calendar of six
months that by default includes the current month.

By closing or reducing other panels on the screen, and depending on the size of
your screen, you can show the months for a period of up to 3 years and six months.

You can review data for up to several decades into the past, if such data has been
recorded, and plan ahead for up to several decades into the future; to display future
or past months, either:

e  Click on the arrows in the names of the months on the left and right of the top
row of months, or

e Click and hold the mouse on the name of a month so that a list of months and
years displays, then move the mouse forwards to scroll up the list or backwards
to scroll down the list; when you reach the required month, ensure that it is
highlighted and release the mouse button

On the calendar, today's date has a red border; if you have scrolled the calendar so

that today's date is not shown, click on the second icon in the toolbar (zl) to
position the current month in the top left of the calendar with today's date
highlighted.

The 'Diary’ panel displays a set of day fields, each of which can contain one or
more markers for an event or task.

The content of the display is determined by the selections you make in the toolbar,
and principally by the object type you select from the first drop-down field:

e  Project Calendar
e Allocated Resources

e Project Tasks
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The structure of the display depends on the period you want to review, specified
using the icons on the toolbar:

e | day (Project Calendar only)

e 5 days (Mon - Fri) (Project Calendar only)
e 7 days (Mon - Sun)

e 3] days

However, in the 'Calendar' panel you can highlight specific periods of between 1
and 7 days (Project Calendar only) and 14, 21, 28, 35 and 42 days, to display just
those periods in the 'Diary’ panel.

If you select a period of between 1 and 7 days, each day is divided into one hour
time intervals; you can adjust the time intervals for these periods, using the toolbar.

For the current day, the current time is also highlighted.

Also, if you click on today's date in the 'Calendar' panel the 'Diary panel' changes to
show the shortest period (7 days or 1 day) for the object type, again with adjustable
time intervals for the times of day.

For displays of 7 or more days, you can scroll up or down to display the
information for earlier or later dates; if you scroll away from today's date, you can
return to it by right-clicking anywhere on the display and selecting the 'Show
Today' option (not Project Calendar).

The toolbar options modify what is displayed on the 'Diary’ panel, and help you to
add certain kinds of information.

The icons and fields in the toolbar, from left to right, have these functions:
e Add New <object> - enables you to create a new record for an event or task

e Assign Resource - for Allocated Resources, enables you to assign a new
resource to the task

e  Show Today - re-focuses the 'Diary' panel and 'Calendar' panel on today's
date, for any object type

e 1,5,7,31 - sets the number of days displayed in the 'Diary' panel

e  First drop-down - identifies the type of information to display: Calendar
events, allocated Resources, or Tasks

e Second drop-down - identifies the type or characteristic of object to filter for
(and depends on the value selected in the first field)

e  Third drop-down - for Allocated Resources, identifies the element type to filter
for

e  Options:
- Configure Event Subtypes - Displays the 'Configure Subtype' dialog, which
you use to define categories
of event to record on the Calendar
- Time Scale - where the display includes times of day, enables you to reset
the time interval
- Show End Time - for the Project Calendar, where the times of day are NOT
shown and an event
occurs within one day, this shows or hides the time at which the event
finishes (the start time displays
automatically)
- Show Time As Clocks - toggle between showing start and end times in
digital format and as a clock face
- Compress Weekend Days - in 31-day format, toggle between showing
Saturday and Sunday as
separate fields and a pair of half-fields
- Show ToolTips - toggle between showing and hiding mouse roll-over
tooltips
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Notes
e The Project Calendar is available in the Corporate, Business and Software Engineering, System Engineering and

Ultimate editions of Enterprise Architect

e In the Lite edition of Enterprise Architect, you can view Calendar entries but not change them
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Calendar

Project Calendar is a display mode of the project Calendar facility. In Project Calendar mode, the 'Diary' panel shows a
selected period of time containing flags for each event that takes place in or through that period. These events can be, for
example, meetings, staff absences or commitments, product releases or public holidays.

You can customize the range of events that you record, using the 'Configure Subtype' dialog.

Access
Ribbon Start > Today > Calendar > Project Calendar
Menu Project | Calendar > Project Calendar

Record an event in the Project Calendar

Step Action

1 Double click on the required day, or the first day in a longer period.

The 'Project Event' dialog displays.

2 In the 'Subject' field, type the name of the event.
3 If the event is to take place at a specific place, in the "Location' field type the name of the place or room.
4 In the 'Category' field, click on the drop-down arrow and select the appropriate categorization:

e Event (such as an external trade show, or internal presentation)
e  Meeting (whether internal or external)
e Milestone/Objective (such as a product test or release)

e People (an absence or commitment of a specific staff member)

5 If the event is likely to occupy one complete day, select the 'All day event' checkbox; this:
e Places the event icon at the top of the day field in the Diary, above any time sections

e Hides the time sections of the 'Start time' and 'End time' fields

6 In the Start time and End time fields, specify the start and end dates and/or times of the event.
In the date section of each field, either:
e  Click on the drop-down arrow to display the current month and select the month and date, or

e  Click on the 'spin' arrows to roll the date forwards or backwards by one day at a time
In the time section of each field, click on the hour or minute components (which are separate) and either:

e Type in the required time or

e  Click on the 'spin' arrows to roll the time backwards or forwards
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10

11

12

In the 'Event Type' field, click on the drop-down arrow and select an appropriate type label for the event;
the options change depending on the value you selected for the 'Category’ field.
This provides the fill color for the event icon, as indicated by the fill box next to each option.

In the 'Defined as' field, click on the drop-down arrow and select the indicator for whether the event is
internal or external to your organization.

If the event consists of a telephone call, select the "Phone Call' checkbox.

In the description field, type any notes required on the event; these display in the mouse roll-over tool tip
for the event on the 'Diary' panel.

If this event repeats at regular intervals, click on the Recurrence button and complete the 'Event
Recurrence' dialog.

Click on the OK button to save the event and display it on the Calendar.

Define a recurring event

Step

1

Action

In the 'Start' and 'End' fields, specify the start and end times of the event; click on the hour or minute
components (which are separate) and either:

e Type in the required time or

e  Click on the 'spin’ arrows to roll the time backwards or forwards

In the 'Duration’ field, click on each of the day(s), hours and minutes portions and either type or 'spin' to
the required value.

The hours and minutes portions are linked to the 'Start' and 'End' fields, so that:

e Asyou edit the 'Start' field or the 'Duration' field, the 'End' field adjusts to maintain the duration
relative to the start time

e Asyou edit the 'End' field, the 'Duration’ field changes to match the difference between the start and
end times

In the 'Recurrence pattern’' panel, select the appropriate radio button for the frequency of the event.

As you select the radio button, the fields on the right of the panel change to further define when the event
recurs.

Select the appropriate radio buttons and field values, with this guidance:
e Daily can be every 1, 2, 3, 4, 5 or 6 days, or every day of the working week

e  Weekly is on one or more specific days of the week, the events being separated by a period of
between 1 and 51 complete weeks

e  Monthly can be on a specific date or a specific day of the month, the events being separated by a
period of between 1 and 11 complete months

e Yearly can be on a specific date or a specific day of a specific month

In the 'Range of recurrence' panel, in the 'Start’ field, specify the date on which the event cycle begins.

Click on the day, month and year components (which are separate) and either:
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e Type in the required value or

e  Click on the 'spin’ arrows to roll the date backwards or forwards

6 Select the appropriate radio buttons to indicate that the recurrence cycle:
e Has no defined end point
e Ends after a specific number of occurrences of the event (type in the number)

e Ends by a specific date (enter the date)

7 Click on the OK button, and again on the 'Project Event' dialog.

The event icon displays at all points in the Calendar where it is scheduled to occur, as defined in the
'Event Recurrence' dialog; the recurrence is indicated by a graphic depicting two recirculating arrows.

8 If the recurrence is no longer required:
e  Double-click on the icon for any occurrence of the event, to display the 'Project Event' dialog
e  Click on the Recurrence button to display the 'Event Recurrence' dialog
e  Click on the Remove Recurrence button; the 'Event Recurrence' dialog closes
e  Click on the OK button; the 'Project Event' dialog closes

Only the first occurrence of the event remains in the Calendar.

Notes

e  The Project Calendar is available in the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions of Enterprise Architect

e In the above editions, if security is enabled you must have 'Manage Project Calendar' permission in order to create,
update or delete Project Calendar events; if security is not enabled, you can change data without this permission

e In the Lite edition of Enterprise Architect, you can view Calendar entries but not change them

®  You can transport a calendar of defined events between projects, using the 'Export Reference Data' and Tmport
Reference Data' options
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Configure Event Subtypes

The 'Configure Subtype' dialog enables you to define additional types of event to record on the Project Calendar, such as:
e Define a new event type within a select event category
e Change an existing event type

e Delete an existing event type

Access
Ribbon Fy -
Start > Today > Calendar : .50 | Configure Event Subtypes
Menu £

®
ot

Project | Calendar : ¥ | Configure Event Subtypes

Manage the event types for your project

Step Action

1 On the 'Configure Subtype' dialog, in the 'Category’ field, click on the drop-down arrow and select the
appropriate category for the event.

2 Click on the '"Type' field and type a suitable name for the event type (or select an existing event from the
list below the 'Category' field).

3 In the 'Color" field, click on the drop-down arrow and select or define a color for the event icon.

4 Click on the Save button to save the new or edited event type to the list for the specified category.

Click on the New button if you are going to create another event type.
5 If the event type is no longer required, click on the Delete button.

6 If required, you can change the sequence of the event types in the displayed list, using the 'Up Hand' and
'Down Hand' buttons at the bottom of the dialog.

7 Click on the OK button to close the dialog; any new event types are available for use in the Project
Calendar.

Notes

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Manage Project Calendar' permission in order to create or delete
Project Calendar event subtypes; if security is not enabled, you can change data without this permission
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e You can transport your defined event types between projects, using the 'Export Reference Data' and 'Import
Reference Data' options
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Allocated Resources

'Allocated Resources' is a display mode of the project Calendar facility, that you can use to:
e Review the allocation of resources across the project over a period of time

e Review the status of the work assigned to those resources

e Display and edit the details of the task assigned to a resource

e  Allocate further resources to an element

e Delete a resource allocation from an element

e Create and send an email to the resource allocated to an element

In 'Allocated Resources' mode, the 'Diary’ panel shows the selected period of time (see the Project Calendar topic), with
at least one icon representing each element in the project to which a resource has been allocated during that period. If an
element has more than one allocated resource, each element:resource combination is represented separately.

Each icon shows the element name and resource name, and indicates the status of the assigned work with one of these
symbols:

e a green square, indicating that the resource has been assigned the work
e agreen tick, indicating that the resource has completed the assigned work
e ared square, indicating that the resource has not completed the assigned work

e asquare divided diagonally with green and red halves, indicating that the assigned work is to be completed within
one working day

Typically, while the work is in progress a resource is represented by:

e Anicon with a green square on the day the work is planned to start, and
® Anicon with a red square on the day the work is planned to finish
When the work is complete, the icons on both days display the green tick.
Resources are initially allocated to elements through the:

e Resource Allocation window, or

e 'Allocated Work' tab of the Personal Tasks window

You can then edit these allocations through either of those windows or through the Allocated Resources Calendar itself.

Access
Ribbon Start > Today > Calendar > Allocated Resources
Menu Project | Calendar > Allocated Resources

Allocate Resources

Field/Option/Button Action
Display/edit details of an Either:
allocated resource e Double-click on any icon for that element:resource combination, or

e Right-click on the icon and select the 'Properties' option
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The 'Assigned Resources' dialog displays, showing the details of the assignment of
the resource to a task on the element.

This dialog has the same content, format and functions as the Resource Allocation
window, in Item mode.

Add resource to element Right-click on any icon for the element and select the 'Assign Resource to <element
name>' option.

The 'Assigned Resources' dialog displays, showing the start and end dates both set
to the date from which you selected the icon, and the 'Allocated Time' field set to
'1"; all other fields are blank.

This dialog has the same content, format and functions as the Resource Allocation
window, in Item mode.

Specify the resource and the role or task that resource is performing, and define the
period for which the resource is allocated to the element.

Message Resource Right-click on any icon for the element:resource combination and select the
'Message Resource <resource name>' option.

The 'Model Message' dialog displays, on which you create and send your message
to the resource allocated to the element.

Delete resource from Right-click on any icon for the element:resource combination, and select the 'Delete
element Resource from <element name>' option.

A prompt displays to confirm the deletion; click on the Yes button.

The icon and any corresponding icons for that element:resource combination are
deleted from the calendar, and the resource is no longer allocated to that element.

Locate element in diagrams Right-click on any icon for the element, and select the 'Find in all Diagrams' option.

in which it is used If the element is used in only one diagram, that diagram displays.

If the element is used in more than one diagram the 'Element Usage' dialog
displays, listing the diagrams in which the element occurs.

Select the required diagram and click on the Open button to display that diagram.
This option also operates on Port and Part Property Type Classifiers.

Locate element in Project Right-click on any icon for the element, and select the 'Find in Project Browser'
Browser option.

The area of the Project Browser containing the element is brought into focus and
expanded, and the element is highlighted.

Locate resource allocation Firstly, click on the end date icon for the element:resource combination to highlight
start date corresponding to it; the corresponding start date icon is also highlighted.

allocation end date If the start date icon is not in view, right-click on the end date icon and select the

'Show Start/End' option; the display scrolls to show the start date and the start date

cell is highlighted.
Locate resource allocation Firstly, click on the start date icon for the element:resource combination to
end date corresponding to highlight it; the corresponding end date icon is also highlighted.

allocation start date If the end date icon is not in view, right-click on the start date icon and select the

'Show Start/End' option; the display scrolls to show the end date and the end date
cell is highlighted.

Refocus display on today's Right-click anywhere on the display and select the 'Show Today' option.

date The display returns to today's date, which is highlighted and outlined.
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Notes

e The Project Calendar is available in the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions of Enterprise Architect

e In the above editions, if security is enabled you must have Manage Project Settings permission in order to allocate
resources to or remove resources from the Project Calendar; if security is not enabled, you can change data without
this permission

e In the Lite edition of Enterprise Architect, you can view Calendar entries but not change them

e As the start and end icons for a completed task are identical, and one-day tasks have only one icon, the methods to
show the corresponding start date or end date for an icon are also useful to show whether the icon is for a start or end
date, or for a one-day task; alternatively, double-click on the icon and review the allocation dates
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Project Tasks

Project Tasks is a display mode of the project Calendar facility, that you can use to:
e Review the tasks across the project over a period of time

e Review the progress of those tasks

e (Create new tasks

e Display and edit the details of the task

e Allocate a resource to a task

e Delete a task

e Create and send an email to the resource assigned to a task

e C(Create and send an email to the owner of the task

In Project Tasks mode, the 'Diary' panel shows the selected period of time (see the Project Calendar topic), with at least
one icon representing each project task scheduled during that period. The icon represents an independent record of the
task - there are no comparisons or validations of the tasks. Therefore you can have separate icons for the same task, with
different resources allocated or no resources allocated; you can even have identical task records, if these serve a purpose
for you.

Each icon shows the task name and resource name, and indicates the status of the task with one of these symbols:
e agreen square, indicating that the task has been scheduled

e a green tick, indicating that the task is complete

e ared square, indicating that the task is incomplete

e asquare divided diagonally with green and red halves, indicating that the task is to be completed within one working
day

Typically, while a task is in progress it is represented by:

e Anicon with a green square on the day the work is planned to start, and

e Anicon with a red square on the day the work is planned to finish

When the work is complete, the icons on both days display the green tick.

Tasks can be created and managed through this view of the Project Calendar, or the:
e 'Tasks' tab of the Project Status window, or

e 'Project Tasks' tab of the Personal Tasks window

Access
Ribbon Start > Today > Calendar > Project Tasks
Menu Project | Calendar > Project Tasks

Manage Project Tasks

Option Action

Create a task Either:
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Display and edit a task

Allocate a resource to a
task

Delete a task

Create and send a message
to the task owner

Create and send a message
to the resource assigned to
the task

Locate task start date
corresponding to task end
date

Locate task end date
corresponding to task start
date

Refocus display on today's
date
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e Double-click on the date cell in which the task is to start
e Right-click on the cell and select the 'Add New Task' option, or

e  (Click on the down-arrow next to the first icon in the Calendar toolbar, and
select the 'New Task' option

The 'Task Details' dialog displays, through which you create the task.

Either:
e  Double-click on the task
e Right-click on the cell and select the 'Properties' option, or

e  (Click on the down-arrow next to the first icon in the Calendar toolbar, and
select the 'Properties' option

The 'Task Details' dialog displays; if necessary, edit the information.

Certain tasks might not initially be assigned to a resource, but might later require
specific assignment to finish them off.

Open the task to edit it, click on the drop-down arrow in the 'Assigned' field and
select the required resource.

Right-click on any icon for the required task and select the 'Delete <task-name>'
option.

You are prompted to confirm the deletion; click on the Yes button.

Right-click on any icon for the task and select the 'Message Owner' option.

The 'Model Message' dialog displays, on which you create and send your message
to the user who owns the task (as identified in the 'Task Details' dialog).

If the task does not have a defined owner, this option does not operate.

Right-click on any icon for the task and select the 'Message Assigned <resource
name>' option.

The "Model Message' dialog displays, on which you create and send your message
to the resource assigned to complete the task (as identified in the 'Task Details'
dialog).

If the task does not have a defined resource, this option does not operate.

Firstly, click on the end date icon for the task to highlight it; the corresponding start
date icon is also highlighted.

If the start date icon is not in view, right-click on the end date icon and select the
'Show Start/End' option; the display scrolls to show the start date and the start date
cell is highlighted.

Firstly, click on the start date icon for the task to highlight it; the corresponding end
date icon is also highlighted.

If the end date icon is not in view, right-click on the start date icon and select the
'Show Start/End' option; the display scrolls to show the end date and the end date
cell is highlighted.

Right-click anywhere on the display and select the 'Show Today' option.
The display returns to today's date, which is highlighted and outlined.
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Notes
e  The Project Calendar is available in the Corporate, Business and Software Engineering, System Engineering and

Ultimate editions of Enterprise Architect

e In the Lite edition of Enterprise Architect, you can view Calendar entries but not change them
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The Model Mail facility provides you with the ability to send, receive and respond to emails within the project team,
under your User Security ID either as an individual user or as a member of a group that has a shared mail inbox. The
'Mail Inbox' tab shows all emails that you have received, and the 'Sent Mail' tab shows all the emails you have created
and sent. Within the facility you can re-organize, forward, delete and mark the emails, both sent and received.

This facility is available in the Corporate, Business and Software Engineering, Systems Engineering and Ultimate
editions of Enterprise Architect, with User Security enabled; the mail system uses the individual and group users defined

in User Security.

Access

Ribbon

Menu

Start > Today > Mail

Construct > Project > Discussion > Model Mail

Project | Model Mail

Review your Model Mail messages

Field/Option/Button

Open a message

Flag

Status

Sender
Subject

Date

Sent
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Action

Double-click on the message.

If the message contains a hyperlink, click on the link to open or display the target
file or object.

Check the flag color to establish the significance of the message (the meanings of
the flag colors should be defined within the project team).

Check for the read or unread icon; unread message items are anyway displayed in
bold.

The name of the project team member who sent the message.

The topic of the message.

Indicates the age of the message, whether it was sent:

The exact date and time the message was sent.

Today
Yesterday
This week
This Month
Last Month
Older
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Select Columns Right-click on the column headings and select the 'Field Chooser' menu option,
which enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Adding the 'To' column will display the user account or group name that this mail
item was sent to; this column is useful to identify whether the message was sent to
you as an individual or as a member of a Group with a Shared Mail inbox - if you
received the message as a member of a shared mail group, remember that your
actions on this message will also affect all other members of this group.

Filter Columns You can filter the mail items listed by displaying the Filter Bar (right-click on the
column headings and select the 'Toggle Filter Bar' option) and typing in the value
(or partial value) to filter on.

For example, if you type your group mail account name in the filter field for the 'To'
column, you will list only those mail items sent to the group mail address, not those
sent to you as an individual.

To clear the value of a filter field, click on the blue cross against that field.

Reorganize messages in the Either:
list e  Click on a column heading to toggle sorting of list items by this column in
ascending or descending order, or

e Right-click on the column heading and select the 'Enable Group Box' option to
organize the messages into groups

Model Mail Toolbar Options

Option Action
Compose Message Open the 'Model Message' dialog, through which you create and send a mail
message.
Delete Messages Delete a selected message or messages; you are prompted to confirm the deletion.
Reply Open the 'Model Message' dialog, through which you create a response to the

sender of the message, which includes a copy of the message and any earlier
messages in the thread.

Reply to All Open the 'Model Message' dialog, through which you create a response to the
sender of the message and the other recipients, which includes a copy of the
message and any earlier messages in the thread.

Forward Open the 'Model Message' dialog, through which you forward the message to other
project team members with, if necessary, your own comments.

Mark as Unread Mark the selected messages as unread.
Mark as Read Mark the selected messages as read.
Viewing Panel Adds a panel to the Model Mail view showing the contents of the currently

selected message. The Viewing Panel can be displayed to the Right or Bottom of
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the message list. Select Hide to show only the message list.

Help Contents Display this Help topic.

Model Mail Context menu options

Option Action
Compose New Message Click to open the 'Model Message' dialog, through which you create and send a
mail message.
Shortcut:
Reply Create a response to the sender of the message, which includes a copy of the

message and any earlier messages in the thread.
Shortcut: Ctrl+R

Reply to All Create a response to the sender of the message and the other recipients, which
includes a copy of the message and any earlier messages in the thread.
Shortcut: Ctrl+Shift+R

Forward Forward the message to other project team members with, if necessary, your own
comments.

Shortcut: Ctrl+F

Set Message Flag Select the appropriate flag color to establish the significance of the message (the
meanings of the flag colors should be defined within the project team).

Mark as Unread Mark the selected messages as unread.
Shortcut: Ctrl+U

Mark as Read Mark the selected messages as read.

Shortcut: Ctrl+Q, or click on the message and press the R key.

Delete Delete a selected message or messages; you are prompted to confirm the deletion.

Manage your sent messages on the Sent Items tab

Field/Option/Button Action
Open a message Double-click on the message.

From the open message you can reply to the sender, reply to the sender and all
other recipients, or forward the message to other team members.

Flag Check the flag color to establish the significance of the message (the meanings of
the flag colors should be defined within the project team).

(c) Sparx Systems 2015 - 2016 Page 69 of 105 Created with Enterprise Architect



User Guide - Team Support 15 July, 2016

To Check the name(s) of the project team member(s) to whom the message was sent.
Subject The topic of the message.
Date Indicates the age of the message, whether it was sent:

e Today

e  Yesterday
e  This week
e Last Week
e  This Month
e Last Month

e Older
Sent The exact date and time the message was sent.
Select Columns Right-click on the column headings and select the 'Field Chooser' menu option,

which enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Adding the 'Sender' column is useful to identify whether you have sent the message
as an individual, or as a member of a shared mail group.

Reorganize messages in the Either:
list e  Click on a column heading to toggle sorting of list items by this column in
ascending or descending order, or

e Right-click on the column heading and select the 'Enable Group Box' option to
organize the messages into groups

Delete messages Right-click on the message and select the 'Delete' option.

You are prompted to confirm the deletion.

Reply to All Right-click on the message and select the 'Reply to All' context menu option.
The 'Model Message' dialog displays.

Forward Right-click on the message and select the 'Forward' option.

The '"Model Message' dialog displays.
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Create a Message

You can use the 'Model Message' dialog to compose messages to project team members within the project, under your
Author ID, and to:

e Reply to messages from other team members
e  Forward messages to other team members

e Link model components to the message, or add hyperlinks to files or other objects of relevance

Access
Ribbon Start > Today > Mail
Construct > Project > Discussion > Model Mail
Menu Project | Model Mail

Create a message to another project team member as a new message, a reply to a
message, or a forwarded message

Step Action

1 If your message or response concerns a diagram or model object, you could click on that object in the
Project Browser now so that it is immediately available to be linked to your message.

2 Select the appropriate toolbar icon, context menu option or message button to create, reply to or forward a
message.

The "Model Message' dialog displays.

3 If you are creating or forwarding a message, or you want to send a reply to a wider audience, for each
person you intend to send the message to:

e  Click on the To: button
A list of project team member and group IDs displays

e  Scroll to the required name and double-click on it
The name is added to the 'To:' field

4 In the 'Subject' field, type or edit the subject of the message as necessary.

5 In the 'Flag' field click on the drop-down arrow and on the appropriate flag color or option for your
message.

6 In the text panel, write the text of your message.

You can format the text using the facilities of the 'Notes' toolbar at the top of the field.

7 If you intend to link a diagram or model object to this message, place the cursor at the appropriate position
in your message text and click on the Insert Quick Link button.
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Select the object you highlighted in Step 1; a hyperlink to that object is inserted in the message text.

8 If you did not select a model object and now intend to link to one, or you want to link to another target
such as a file, Model Search or Team Review message, click on either:
e The 'Hyperlink' icon in the toolbar or

e The Insert Quick Link button and select the 'Other’ option
The 'Hyperlink Details' dialog displays; create the required link.

9 Click on the Send button to send the message to the recipients.

Notes

e  This facility is available in the Corporate, Business and Software Engineering, Systems Engineering and Ultimate
editions of Enterprise Architect, with User Security enabled
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Element Discussions

Using the 'Element Discussions' tab of the dockable Discussions window, you can select an individual element and
develop a discussion or review that is directly associated with that element. This makes it easy to locate, view and
contribute to a discussion, or more than one discussion, on the selected element.

You can review and participate in discussions on different elements simply by clicking on each element in turn; the
Discussions window immediately switches to the discussions of the new selected element.

As a discussion develops, the number of responses is shown next to the original Document, in brackets; therefore you
can see when a discussion has a new reply without having to expand and work through the thread. You can also set a
status of 'Awaiting Review' or 'Closed' on a discussion, indicated by an icon against the posting. This helps you to
resolve and close off points raised in the discussion, so that they do not continue indefinitely. You can also delete the
whole posting or specific replies, to balance retaining discussion history with removing irrelevant information.

A further facility of the Discussions window is the 'Model Chat' tab and text box, which you can use to follow and
participate in quick conversations on a point of interest, not necessarily connected with the selected element. This facility
is described separately, in the Model Chat Help topic.

Access
Select an element, then open the Discussions window using one of the following methods:

Ribbon Start > Today > Discussion > Discuss > Element Discussions
Construct > Project > Discussion > Discuss Element > Element Discussions

Specification - Specify > Element > Discuss > Element Discussions

Menu Select element | Element | Discussions

Operations in Element Discussions

Operation Action

Create a discussion The window displays the message Create new Discussion. Double-click on this
message and type your posting as continuous text (no carriage returns). The text
automatically wraps at the border of the Discussions window.

If you do need to break your text into paragraphs, press Ctrl+Enter at the point at
which to break the text.

When you have finished typing, click off the text or press the Enter key.

e An open expansion box, a =] icon, your user ID and the date and time of
posting display above your text

e  The messages Post Reply and Create new Discussion display beneath your text

You can also right-click on the window and select the 'Create New Discussion'
menu option. All new discussions are added underneath existing discussion threads.

Add a response Double-click on the 'Post Reply' message and type your response as continuous

text.

When you have finished typing, click off the text or press the Enter key.

(c) Sparx Systems 2015 - 2016 Page 73 of 105 Created with Enterprise Architect



User Guide - Team Support 15 July, 2016

e A “icon, your user ID and the date and time of posting display above your
text

e The message Post Reply displays beneath your text

e  The number of responses posted displays or is incremented to the left of the
original posting

You can also right-click on a post and select the 'Post Reply' menu option. All new
discussions are added underneath existing discussion threads.

Edit postings Once a discussion or reply has been posted (you have clicked off the message body
or pressed the Enter key) you cannot edit it.

However, until you have posted the message you can move the cursor anywhere in
the message body and add or delete text.

As you type, the editor automatically checks the spelling and underlines possible
spelling errors in red. You can backspace or move the cursor to the errors to correct
them, as long as you do not post the message.

Set discussion status The icon against a new discussion indicates that the discussion has the status of
'Open'. To change the status, right-click on the discussion item and select either:

e 'Discussion Status | Awaiting Review' (}-“5?3') or

e 'Discussion Status | Closed' (&.:':-)

If the discussion already has one of these statuses, you can also select the 'Open'
option to return the discussion to 'Open' status.

The status settings are simply labels - they do not have an impact on posting replies,
deleting replies or deleting the discussion.

Delete a discussion or reply Right click on the original discussion or a reply, and select the Delete Selected'
menu option. A prompt displays to confirm the deletion. Click on the Yes button.

If you delete a discussion, all replies associated with that discussion will be deleted
as well.

If you delete a reply in a thread, the count of replies against the original posting is
decremented.

Review Discussion History Either:
e  (lick on the element name button across the top of the window and select the
'Discussion Review' option, or
e  Select the 'Start | Today > Discussion > Manage Discussions' menu option
This displays a table of all existing discussion items on elements. You can:

e Add to or reduce the number of columns using the 'Field Chooser', and display
the Filter bar to filter the list for discussions having a specific property such as
the user who posted the discussion item, or the person who created the element
(element author)

e Right-click on a discussion in the window and select to show the discussion in
a preview pane on the right or at the bottom of the window, to instantly see the
discussion thread as you click on it in the list; you can also hide the preview
pane if you do not need it

e List the discussions posted over a number of days - either Today or 7, 30 or 90
days prior to today, by right-clicking on the display and selecting the "Visible
Timeframe' option

e Find the element in a selected discussion in the Project Browser or diagrams

e  Click on the 'Edit discussion' option to read the full text and replies for a
selected discussion, in the Discussions window; you can work on the
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discussions as normal - that is, delete the discussions, add replies or new
discussions, refresh the display and switch to discussions for a different
element

e Refresh the list to include any discussions that have been posted since you
opened the discussion review

Notes

e The Discussions facility is available in the Corporate and extended editions of Enterprise Architect

e Ifthe editor does not highlight spelling errors, select 'Start > Workspace > Preferences > Objects' and deselect the
'Disable Spelling' checkbox
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Model Chat

The Discussions window provides the facility of following and participating in quick conversations on a point of
interest, with members of a selected user group. The user groups are those defined in User Security.

Each initial comment or response is a separate message, listed in the Discussion window's 'Model Chat' tab in date/time
order with the most recent message at the top of the list. The messages are independent of the currently selected model
object and the full list displays whenever the user group is selected in the 'Model Chat' tab. As the messages are
independent of any model object, they do not appear in the 'Discussion Review' tab (Manage Discussions) or 'Recent
Discussions' report (which are element-based).

You can filter the messages by the time interval prior to today, and you can set up a check to notify you when new
messages are posted by members of one or more user groups.

An example of a Model Chat session.

Discussions v 3 X

Marketing -
Send

‘-’»f;- Tom O'Reilly 1/06/2016 4:07 PM A

I should have something for you within the hour..

& Tom O'Reilly 1/06/2016 4:04 PM

I need to propose alternative approaches based on an estimate
from the tech sales rep of the work involved

&% Craig Allan 1/06/2016 4:04 PM

Mo, she's looking at the usefulness of the scenarios

§& Ken Harkin 1/06/2016 4:03 PM
Any new information on the requirements acceptance criteria from
the tester?
-
M 4 kM Element Discussions +Model Chat
@ Notes | Discussions
Access
Ribbon Start > Today > Discussion > Discuss > Model Chat
Construct > Project > Discussion > Discuss Element > Model Chat
Specification - Specify > Element > Discuss > Model Chat
Menu Element | Discussions > Model Chat
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Select a User Group

Initially, the button at the top of the Model Chat' tab displays the name 'Select a Discusion Group'. Click on the button
and on the name of the user group to send messages to. The name of the currently-selected user group then becomes the
name of the button.

If you want to communicate with a different group, click on the button again and select the name of that group.

If you do not want to continue chatting, you can select 'Disconnect from Current Discussion'.

Create a message

Step Description

1 At the top of the 'Model Chat' tab, in the text field, type your message. You can
right-click on the text and select from a number of editing context menu options.
You can also create glossary terms and new elements from the text you are typing,
or links to existing elements.

If you want to create a paragraph break, press Ctrl+Enter (the Enter key alone
will submit the message).

2 When you have completed your message, click on the Send button or press the
Enter key. The message displays in the list underneath the text field.

Review Messages

Once a message has been sent, it cannot be edited. However, you can delete a message by right-clicking on it and
selecting the 'Delete Message' option.

Messages sent by other people to the currently-selected User Group display in your screen immediately. Messages
deleted by other users do not disappear immediately. To update your list, right-click on it and select the 'Reload
Messages' option.

Monitor User Groups for Messages

You can set up a 'watch' on selected user groups to notify you when a member of one of those user groups posts a
message, and the 'Model Chat' tab is either set to a different user group or not visible.

The notification is a New Model Discussion button that displays in the bottom right of the Status Bar when a message is
posted from a selected user group. The button also displays if a message is posted in the thread you have been reading,
and the 'Model Chat' tab is not visible. Click on the button to redisplay the 'Model Chat' tab with the message thread.

If you are monitoring more than one user group, the New Model Discussion button provides a menu to indicate which of
the selected groups has posted a new and unread message. When you click on a group, the '"Model Chat' tab displays with
the appropriate thread of messages.

To set up a watch for messages from a user group:

1. Click on the 'Options' icon on the right of the <User Group> button, and select the 'Monitor Groups for new
Messages' option.

2. Select a user group to monitor. If you want to monitor more than one group, either:
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- Do steps 1 and 2 again for each individual group to monitor, or
- Select the 'All' group to check for messages from any of the user groups

3. Select the "Monitor Groups for new Messages' option again, and click on the 'Check for new Messages Every' option.
Click on the interval of time at which the system will check for new messages - every minute, or up to every ten
minutes.

4. If you want to cancel monitoring a specific group, repeat steps 1 and 2. Clicking on a selected group will deselect it.

5. If you want to cancel monitoring any of the selected groups, perform step 1 and then click on the 'None' option.

Filter messages by age

The 'Options' icon provides the 'Message Visibility' option, to limit the display of messages to those posted within a
certain number of days prior to today's date.

When you select this option, a menu displays from which you select to display only messages posted today (the default),
or within the last 7, 30 or 90 days.

If you do not want to limit the display of messages to an interval you have set, you can cancel it by selecting the 'All'
option.
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Team Review

If the project team members require a forum in which to discuss the development and progress of the project, they can
make use of the facilities of the Enterprise Architect Team Review.

Access

Ribbon Construct > Project > Team Review
Menu Project | Team Review

Keyboard Shortcuts Ctrl + Alt+U

Features

Feature Description

Structure A point of discussion and the responses (Comments) to that point are created as
Documents. Documents are held in Topic groups, which are in turn organized into
Categories; your organization decides on the grouping and organization of
Documents.

You can create text to explain Categories and Topics, and you can create and
respond to Documents and Comments on Documents.

Displays The Team Review has two main displays:

e The Team Review window is used to create new Categories and Topics and to
delete messages; you operate on it by selecting options from the context menu
Each item in the hierarchy displays a mouse-over tooltip, showing the item
title, the author's name and the date and time the item was created

® The 'Team Review' tab, in the main work area, is used to create, view, edit,
print, and comment on Documents, and to create and maintain the descriptions
of Topics and Categories
This tab has a status bar that shows the item author's name, the date and time
the item was created, and the date and time the item was last modified

Facilities Within the Team Review you can:

e Select to display and edit an item in the 'Team Review' tab, by clicking on the
item name in the Team Review window

e  Search for text strings in the item titles to locate Documents on a specific
subject, using the 'Search' icon in the toolbar of the Team Review window

e Add resources to a Category, Topic or Document, such as diagram images and
XMI files of Packages; these are held in a Resources folder under the selected
Team Review item

e Link model elements, diagrams, external files and other Documents to a
Document

e Link to a Team Review Document from the linked document on an element
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Specification Manager

Icons

Notes

15 July, 2016

Change the loading behavior of the Team Review

Access Team Reviews from other projects, including those on other servers

The Team Review acts as a repository for the review documents generated in the
Specification Manager. These documents are automatically stored in Topics
within the Formal Reviews Category, but you can redirect documents to a different
Topic from either:

The Specification Manager, using the 'Bind Package to Team Review Folder'
option, or

The Team Review, using the 'Bind to Project Browser Package' option

Each item in the Team Review window has an icon that indicates the nature or
status of the item. The meaning of each of these icons is explained here:

B . Document (name in bold indicates Document is unread)
m - Comment (name in bold indicates that Comment is unread)

! - Protected by password (also on Category and Topic icons); a blue icon

indicates that a user with the password has opened the item, and a red icon
indicates that the item is locked

= Status Awaiting Approval (also on Category and Topic icons)
- Status Approved (also on Category and Topic icons)

a. Status Rejected (also on Category and Topic icons)

=. Category (name in bold indicates Category is unread)

- Topic (name in bold indicates Topic is unread)

g Resources folder for a Category, Topic or Document

< Linked objects folder for a Category, Topic or Document
. Diagram or clipboard image within the Resources folder

Gl - XM file of a Package, within the Resources folder

e  You can transport your Team Review set-up between projects, using the 'Export Reference Data' and 'Tmport

Reference Data' options
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Work on Team Review Items

Within the Team Review, you can perform a wide range of operations on the Documents and the Topics and Categories
that contain them. These operations include creating an item, commenting on a Document, password-protecting an item
so that it is not accidentally changed, accessing protected items, adding resources to an item, and deleting an item. All of
these operations are accessed through the context menu in the Team Review window.

Access

Open the Team Review window using one of the methods described below, then right-click on an item

Ribbon

Menu

Keyboard Shortcuts

Team Review Options

Option

New Category

New Topic

New Document

New Category From
Template

New Topic From Template
New Document from

Template

New Comment

Rename

Copy Path to Clipboard

Show Contents
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Construct > Project > Team Review

Specification - Specify > Specification > Team Review > Open Team Review
Project > Team Review

Ctrl + Alt+U

Action

Add a new Category, new Topic or new Document to the Team Review.

Alternatively, click on the New Topic' or 'New Document' icon in the window
toolbar.

Add a new Category, new Topic or new Document, based on a defined template.

Create a response to the selected Document.

Alternatively, click on the New Comment' icon in the window toolbar.

Edit the name of the currently-selected item, in situ.
Shortcut: F2

Copy the path of the currently-selected item to the clipboard.

You can then paste the path into a document or file to add the discussion to any text
concerning the item.

Shortcut: Ctrl+C

Display the description or text of the item selected from the Team Review window,
if the 'Team Review' tab is not yet open.
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Share Resource

Add Package From Current
Model

Import to Current Model

Image of Active Diagram

Active Profiler Report

Image From Clipboard

View Image

Copy Image To Clipboard

Refresh Category 'xyz'
Refresh Topic 'xyz'
Refresh Document 'xyz'

Refresh Comment 'xyz'
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(If anything other than a Resources folder is selected.)

Add an item into the Resources folder under the selected Category, Topic or
Document. If a Resources folder does not exist, one will be automatically created.

Available options:

e Package from Current Model
e Image of Active Diagram

e  Active Profiler Report

e Bookmark Active Website

e Image from Clipboard

(If a Resources folder is selected.)

Export a Package as an XMI file from the current model as a resource of the
selected Category, Topic or Document.

You browse for and select the required Package using the 'Select <item>' dialog.

(If a Package XMI file resource is selected.)
Import the resource Package to the current model.

You browse for and select the required target Package using the 'Select <item>"'
dialog; the resource is imported as a child of that Package.

This is a useful option for transferring relevant Packages from the Team Review of
one model into another model.

(If a Resources folder is selected.)

Add an image of the currently-displayed diagram as a resource of the selected
Category, Topic or Document.

You are prompted to provide a reference name for this image.

(If a Resources folder is selected.)

Add an active Profiler Report as a resource of the selected Category, Topic or
Document.

You are prompted to browse for and select the appropriate active report.

(If a Resources folder is selected.)

Add an image held on the clipboard as a resource of the selected Category, Topic or
Document.

(If a diagram image resource is selected.)
Open the View Image window, containing an image of the selected diagram.

Alternatively, double-click on the image name.

(If an image resource is selected.)

Copy the image or diagram image to the clipboard.

Refresh the currently-open Category, Topic, Document or Comment, getting new
Comments, Documents and Topics that other users might have created.

However, if you open a different Category, Topic or Document the Team Review
always displays the latest information from the database.

Alternatively, click on the 'Refresh' icon in the window toolbar.

Page 82 of 105 Created with Enterprise Architect



User Guide - Team Support

Reload Current Connection

Review Status

Mark

Bind to Project Browser
Package

Security Options

Connections...

Options...

Delete Category 'xyz'
Delete Topic 'xyz'
Delete Document 'xyz'
Delete Resource 'xyz'

Delete Comment 'xyz'

The Mark Submenu

Option
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Reload the entire Team Review connection, getting new Categories, Topics and
Documents.

Assign or clear a status marker against the selected Category, Topic or Document;
you can mark the item as:

e  Awaiting Approval
e Approved
e Rejected

Or clear the marker (None).

Mark the selected item (and, if appropriate, its contents) as read or unread.

The names of unread (such as newly-posted) items are in bold. When you open the
item, the name reverts to normal type.

Bind the selected Topic to a Package in the Project Browser, so that Review
Documents created in the Specification Manager for that Package are
automatically stored in the Topic.

When you select this option, the 'Select Package to Bind' dialog displays, on which
you browse for and select the Package to bind the Topic to.

Access one of three options:
e 'Apply Password Lock' - to display a prompt to enter a security password

e 'Unlock for Editing' - to display a prompt to enter the set password so that you
can edit the item

e 'Remove Password Lock' - to display a prompt for the set password, which is
then removed

When you set the password, an exclamation mark icon is added to the Category,
Topic or Document name.

Access other Team Reviews from other Enterprise Architect models or models
located on servers.

Alternatively, click on the drop-down arrow in the 'Connection Options' field in the
window toolbar, and select one of the listed models.

Use the '<Configure Connections>' option to add and connect to additional Team
Reviews.

Change the loading behavior of the Team Review.
Delete this Category, Topic, Document or Comment and all sub-topics and
sub-documents, or delete the resource attached to the item.

Alternatively, click on the item and press the Delete key.

A confirmation dialog displays; click on the Yes button to remove the item and any
dependent items from the Team Review.

Action
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All items as Read Mark the entire contents of the Team Review as read.
All items as Unread Mark the entire contents of the Team Review as unread.
Branch as Read Mark this item and all its contents as read.

Branch as Unread Mark this item and all its contents as unread.

'xyz' as Unread Mark only this item as unread.
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Add a New Category

You can add new Categories to the Team Review, in which to store related Topics and Documents.

Access
Ribbon Construct > Project > Team Review
Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review
Keyboard Shortcuts Ctrl + Alt+U

Create a Category

Step Action

1 Right-click on a blank area in the Team Review window and select the 'New Category' option.

A new 'Category' icon displays in the hierarchy.

Team Review R ox

f: "E <Cument Model= -

i [ Formal Reviews

= |

i+ g Mot From SM
i [ specMan

2 Overtype the New Category text with the name of the Category, and click off the name.

The Category description editor displays in the 'Team Review' tab; type the appropriate Category
description, if required.

3 Add new Topics and/or resources to the Category.

Create a Category - Alternative

Step Action

1 Right-click on a blank area in the Team Review window and select the 'New Category from template'
option.

A new 'Category' icon displays in the hierarchy.
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2 Overtype the New Category text with the name of the Category, and click off the name.
The 'New Category from Template' dialog displays.

3 Click on the 'Template' drop-down arrow and select a predefined template for the Category description.
Click on the OK button.

4 The Category description editor displays in the "Team Review' tab; type the appropriate Category
description, if required.

5 Add new Topics and/or resources to the Category.
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Add a New Topic

In the Team Review you can add new Topics to a Category, in which to store related Documents and their Comments.

Access
Ribbon Construct > Project > Team Review
Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review
Keyboard Shortcuts Ctrl+ Alt+U

Create a new Topic

Step Action

1 Either:
e Right-click on the required Category name in the Team Review window and select the 'New Topic'
option

e  Click on the Category name and click on the 'New Topic' icon in the Team Review toolbar, or
e C(Click on the Category name and press Ctrl+N

A new 'Topic' icon displays under the Category name.

2 Overtype the New Topic text with the name of the Topic, and click off the name.
The Topic description editor displays in the "Team Review' tab; type the appropriate Topic description, if
required.

3 Add new Documents and/or resources to the Topic.

Create a new Topic - Alternative

Step Action

1 Right-click on the required Category name in the Team Review window and select the 'New Topic from
Template' option.

A new 'Topic' icon displays under the Category name.

2 Overtype the New Topic text with the name of the Topic, and click off the name.
The New Topic from Template' dialog displays.
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3 Click on the "Template' drop-down arrow and select a predefined template for the Topic description.
Click on the OK button.

4 The Topic description editor displays in the "Team Review' tab; type the appropriate Topic description, if
required.
5 Add new Documents and/or resources to the Topic.
Notes

e Ifyou already have the Team Review tab open, the New Topic from Template' dialog displays as soon as you select
the 'New Topic from Template' menu option; you can click on and overtype the Topic name after you have created
the Topic description
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Add a New Document

Within the Team Review, you can create a new Document on a Topic as either:
e A blank Document
e A Document based on a predefined template, or

e A Document from a file link

Access
Ribbon Construct > Project > Team Review
Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review
Keyboard Shortcuts Ctrl + Alt+U

Create a blank Document

Step Action

1 Either:

e Right-click on the appropriate Topic name in the Team Review window and select the 'New
Document' option

e  Click on the Topic name and on the 'New Document' icon in the Team Review toolbar, or
e  Click on the Topic name and press Ctrl+N

A new 'Document' icon displays underneath the Topic name.

2 Overtype the New Document text with the name of the Document, and click off the name.

The text editor displays in the "Team Review' tab.

3 Type the text of the Document as required.

Create a Document based on a predefined template

Step Action

1 Right-click on the appropriate Topic name in the Team Review window and select the New Document
from template' option.

A new 'Document' icon displays in the hierarchy.
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2 Overtype the New Document text with the name of the Document, and click off the name.

The New Document from Template' dialog displays.

3 Click on the drop-down arrow in the 'Template' field, and select a predefined template for the Document
contents.
4 Click on the OK button.

The template structure is displayed in the '"Team Review' tab.

5 Type in or paste the text of the Document.

Create a Document based on a link to an external file

Step Action

1 Open a file browser (such as Windows Explorer) and locate the file.

2 Click on the file name and drag it onto the appropriate Topic name in the Team Review window.
A new 'Document’ icon is created underneath the selected Topic, and the body of the Document is shown
in the 'Team Review' tab.

A link to the source file is created at the start of the message.

3 Click twice on the New Document text in the Team Review window, and overtype the text with the name
of the Document.

4 In the 'Team Review' tab, create and edit text around the file link, and add further links if required.

When you have created the Document

You can Detail
Create links from the To elements and diagrams from the:
Document

e Project Browser
e Model Search
e  Model Views window, or

e Package Browser

Create links from the Such as:
Document to Team Review e Categories
objects .
e Topics, and
e Documents
Create links from the These links can be either in the text of the Document or on the Category, Topic or
Document to external files Document in the Team Review window (the link is added to the Model Links
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folder for the Team Review item).

Add resources to the It is simple and convenient to link to the resources that are the subject of discussion
Document or that illustrate points in the discussion.

Receive Comments on the The objective of the Team Review is to discuss aspects of development, so you can
Document from other users expect to receive Comments on the Documents that you have posted, and to create

Comments on the material posted by your colleagues.
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Comment on a Document

You use the Team Review as a forum for discussion of items and issues within the project, so when you read a
Document on a particular point (or a response to that Document) you might want to respond with your own Comment.

You can create a Comment directly from the Document you are responding to, from material that you want to use as your
response, or from a predefined document template.

Access
Ribbon Construct > Project > Team Review
Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review
Keyboard Shortcuts Ctrl + Alt +U

Create a Comment in the Team Review

Step

1

Action

Either:

e Right-click on the required Document (or Comment) in the Team Review window and select the
'New Comment' option

e  (Click on the Document name and on the 'New Comment' icon in the Team Review toolbar, or
e  Click on the Document name and press Ctrl+N

A Re:<Documentname> entry displays underneath the Document you are replying to, and the cursor
becomes active in the 'Team Review' tab so that you can create and edit your response.

Type in, format and save the contents of the Comment.

Create a Comment from external material

Step

1

Action

Open a file browser (such as Windows Explorer) and locate a file containing the material you want to use
in your response.

Click on the file name and drag it into the Team Review window, over the Document to which you are
replying.
A prompt displays for you to specify whether to:

e (Create a new Comment containing the text of the file (the file name displays as the Comment name)
or
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e  Add the file to the original Document as a Model Link

3 If necessary, edit, format and save the contents of the reply.

Create a Comment based on a predefined template

Step Action

1 Right-click on the appropriate Document name in the Team Review window and select the New
Comment from template' option.

A new 'Comment' icon displays in the hierarchy, and the New Document from Template' dialog displays.

2 Click on the drop-down arrow in the 'Template' field, and select a predefined template for the 'Comment'
contents.
3 Click on the OK button.

The template structure is displayed in the 'Team Review' tab.

4 Type in or paste the text of the Document.

When you have created the Comment

You can

Create links from the
Comment

Create links from the
Comment to Team Review
objects

Create links from the
Comment to external files

Add resources to the
Comment

Receive replies to the
Comment from other users

(c) Sparx Systems 2015 - 2016

Detail

To elements and diagrams from the:
e Project Browser

e  Model Search

e  Model Views window, or

e Package Browser

These links can be to related Team Review:
e (Categories
e Topics and

e  Documents

These links can be either in the text of the Comment or on the parent Category,
Topic or Document in the Team Review window (the link is added to the Model
Links folder for the Team Review item).

It is simple and convenient to link to the resources that are the subject of discussion
or that illustrate points in the discussion.

The objective of the Team Review is to discuss aspects of development, so you can
expect to receive replies to the Comments that you have posted, and to create
Comments on the material posted by your colleagues.
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Protection Against Editing

When you have created a Team Review Category, Topic or Document containing text, the item text is exposed to
change by any user who has access to the Team Review. You can protect the item against unrestricted changes by setting
a password on it. The password only refers to that item; to protect the text of Topics, Documents or Comments
subordinate to the item, you set a password on each of them as well.

When the password is set, only those users who have the password can edit that item, and only when they specifically
enter the password to unlock that item. Any other user of the Team Review can still view the protected item.

The password does not protect the item from operations on the item as a whole, including being deleted.

Notes

e  The use of a password on an item is indicated by an exclamation mark against the item in the Team Review
window; a blue icon indicates that a user with the password has opened the item, and a red icon indicates that the
item is locked

e When you click on an item to set a password, the item opens; you can edit the item after you have set the password,
while it is still open

e  Once a password-protected item is closed, any user who wants to edit the item must first select to unlock the item for
editing and then enter the password set on the item

e Unlocking is specific to the user; the item remains locked to other users until they enter the password themselves

e  If the password becomes unnecessary, you can remove it from the item
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Edit an Item

When you have created a Category, Topic, Document or Comment, you edit the text within it using the Team Review
editor. This is based on the Document editor, which is used to edit report documents and linked documents throughout
Enterprise Architect.

You can also change the name of the item by selecting it, pressing F2 and typing the new name.

Access

Open the Team Review window using one of the methods outlined below, then double-click an item, or select the item
and press Enter, to open the Team Review editor.

Ribbon Construct > Project > Team Review

Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review

Keyboard Shortcuts Ctrl + Alt +U

Option Descriptions

The editor menu option descriptions are grouped according to the actions you are performing.

Actions

Creating and importing documents
Configuring the editor page display and formatting tools shown

Incorporating stylesheets, special texts and Tables of Contents

Managing the base styles in the Normal.rtf style template file

Moving through, searching and selecting text

Formatting characters and text strings

Formatting paragraphs and text blocks

Inserting tab points

Inserting sections, columns and page breaks, and repaginating

Inserting and editing page headers and footers, and footnotes and endnotes
Inserting tables

Inserting hyperlinks and bookmarks (including using the 'New', 'Link to Existing Element' and 'Hyperlink' options
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on the 'Create' context menu)

Inserting images, OLE objects, frames and drawing objects
Printer setup and printing documents

Check spelling and use of terms

Tracking, accepting and rejecting changes to the text
Protecting document text from accidental change

Create and refer to definitions of Glossary terms in the Project Glossary (using the 'Create | Glossary Definition'
context menu option)

Notes
e To undo one or more immediately previous edits, press Ctrl+Z, or select the 'Edit | Undo' menu option; you can still

undo a change even after you have saved the change

e To redo one or more immediately previous undone edits, press Ctrl+Y, or select the 'Edit | Redo' menu option
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Add Object Links

In the Team Review window you can create hyperlinks from a Document to any elements and diagrams that are
associated with it. This helps you to:

e Rapidly navigate to the objects in the Project Browser

e  Access the element properties, and

e  Open a diagram directly from the Team Review

You can also create links to:

e  Other Categories, Topics and Documents in the Team Review window

e [External files from a file browser

Facilities
Facility Action

Associate an element, Drag the object over the required Category, Topic or Document in the Team

diagram, external file or Review window, from the:

Team Review item with a e Project Browser

message
e Package Browser
e  Model Views window
e  Model Search window or
e External file browser
To create a link to another Team Review item, press Ctrl as you drag that item over
the required Category, Topic or Document.
If it does not already exist, a Model Links folder is created under the selected Team
Review item, and the link to the dragged object is added to the folder.

Associate an external file From any browser, click on and drag the file name into the text of the message.

with the message text The filename becomes a link to the file; click on it to display the contents of the

file.

The external file name also becomes a link to the file within the message when you
drag the filename onto a Topic to create a Document.

Review Options
To review an object in the Model Links folder, right-click on the object to display the navigation context menu.
Option Action

Open Open the linked diagram or external file.

Alternatively, double-click on the diagram link.
Properties Display the Properties' dialog for the selected element or diagram.

Alternatively, double-click on the element, attribute or operation link to open the
'Properties' dialog of the object.
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Create (Edit) Linked Either:

Document e Open the 'New Linked Document from Template' dialog, to begin creating a
new Linked Document on the element, or

e Open the 'Linked Document Editor' to change an existing Linked Document

Find in all Diagrams Open the diagram in which the element is used, or display a list of several diagrams
in which the element has been used.

Find in Project Browser Highlight the element or diagram in the Project Browser.
Locate Item Highlight, in the Team Review window, the Team Review item linked to the
message.

Alternatively, double-click on the link in the Model Links folder.

Delete Model Link Delete the association between the Document and the object.
<name>
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Team Review Resources

Whilst having a discussion through the Team Review, it is convenient to link to the resources that are the subject of
discussion or that illustrate points in the discussion. Such resources include:

o XMI files of Packages within the current project
e  Active Profiler reports

e Images of currently-active diagrams

e Images currently captured on the clipboard

e Bookmarks to currently active websites

You can link to such resources from Category or Topic notes, or from a Document. The resource links are created in a
Resources folder underneath the selected Category, Topic or Document, as shown:

EI _fll Diagrams
N = _'I Elements
= _,ﬂ RE:Elements

= .B Fesources
...... [z Timing
L [§] Data Model

Access

Open the Team Review window using one of the methods outlined below, then;

Right-click on <object> | Share Resource | <resource type>

You create the Resources folder by creating a link to a resource underneath the selected Category, Topic or Document.
Similarly, you delete the Resources folder by deleting the last resource within it. Having added a resource, you can
right-click on it and use a further context menu to:

e Reimport the Package XMI files to the model or
e Display the images

Ribbon Construct > Project > Team Review

Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review

Keyboard Shortcuts Ctrl + Alt +U
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Search Team Review

The Team Review provides the facility to search the titles of all Team Review items, to locate items referring to a
specific subject.

Search the Team Review

Step Action

1

In the Team Review window toolbar, click on the E£200 (Search) icon.
The search panel displays underneath the toolbar.

2 In the blank field, type the text string to search for.

3 If required, select the 'Match Case' checkbox to locate text with the same case as the search string.

4 If required, select the 'Match Whole Word' checkbox to locate only complete words that match the search
string.

5 Click on the Find button.

The search locates the first instance of the search string in the title of a Category, Topic, Document or
Comment, and displays the contents of that item in the 'Team Review' tab.

6 To locate further instances of the text string, click again on the Find button.

7 To close the search panel, click again on the 'Search' icon in the toolbar.
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Team Review Options

You can change the loading behavior of the Team Review, using the 'Team Review Server Options' dialog. If you
change the settings, the new loading behavior is not applied until you restart the Team Review.

Access

Open the Team Review window using one of the methods outlined below, then right-click in the Team Review window
and select Options

Ribbon Construct > Project > Team Review

Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review

Keyboard Shortcuts Ctrl + Alt +U

Team Review Options

Field/Option/Button Action

Preload items less than Type the threshold item size (in KB) below which the items will be preloaded and
above which item data is only loaded when selected.

Load item data when The fastest loading option. Team Review data is only loaded on demand; for
required example, when you read a Document.
Preload all data Caches the entire contents of the Team Review on load; this takes longer to load

but, once completed, navigating the Team Review is faster.

Mark All Unread Resets all Documents you have read to 'unread' (bolds all items in the Team
Review).
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Team Review Connections

If you are modeling in a different model from the rest of your team, you can switch to Team Reviews from other
Enterprise Architect models, including models located on servers. This connects only to the Team Review for the
selected model; it does not change the model open in the Project Browser or anywhere else in the system.

Access

Open the Team Review window using one of the methods outlined below, then either:
e right-click on the Team Review Window and select Connections, or

e click on the 'Connection Options' drop-down field and choose 'Configure Connections'.

Ribbon Construct > Project > Team Review

Specification - Specify > Specification > Team Review > Open Team Review
Menu Project > Team Review

Keyboard Shortcuts Ctrl + Alt+U

Switch to another Team Review

Step Action

1 Select the appropriate model name from the drop-down list in the 'Connection Options' field, to connect to
the Team Review for that model.

If the required model is not listed, click on the '<Configure Connections>' option; the 'Team Review
Server Connections' dialog displays.

Go to Step 3.

2 Alternatively:

Right-click anywhere in the Team Review window and select the 'Connections' option; the 'Team Review
Server Connections' dialog displays.

In the list in the 'Connections' panel, select the checkbox against the appropriate model name to connect to
the Team Review for that model, then click on the Open button.

The connection now switches to the Team Review in the selected model.

If the required model is not listed, go to Step 3.

3 Select the appropriate 'Connection Type' radio button and click on the New button.

e For aproject file, a browser dialog displays through which you can search for and select the
appropriate model

e For a model in a DBMS data repository, the 'Microsoft Data Link' dialogs display, through which
you can locate and connect to the repository

4 When you have selected and opened or connected to the required Enterprise Architect model, and returned
to the 'Team Review Server Connections' dialog, the model name displays in the 'Connection Name' field
and in the 'Connections' panel.
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5 Select the checkbox against the model name and click on the Open button to connect to the Team
Review for that model.

The Team Review now shows the discussions in the selected model.

Fields/Options on the Team Review Server Connections dialog

Field/Option Action
Connection Name Verify the name of the selected model.
Connection Type Select the appropriate radio button for the type of Enterprise Architect model to

locate: a local project file or a model on a remote server.
Target Model Verify the path to the selected model.

New Click on this button to display the file browser or 'Data Link Properties' dialog to
select the model for a new Team Review connection.

Delete Click on this button to delete the currently selected connection from the
'Connections' list. There is no confirmation prompt; the connection is immediately
removed from the list.

Connections View all Team Review connections created; click on the checkbox against the
required connection.

Open Click on this button to switch the Team Review to the selected connection and to
close the dialog.
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